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2

Trademark Notice

• Microsoft, Windows, and Windows Media are registered 
trademarks of Microsoft Corporation in the United 
States and other countries.

• Macromedia and Flash are either registered trademarks 
or trademarks of Macromedia, Inc. in the United States 
and other countries.

• Other system names, product names and company 
names appearing in this manual are trademarks or 
registered trademarks of their respective holders. In this 
manual such names are not indicated by ® or ™ 
symbols.

NOTICE TO USERS

© 2004 Sony Corporation. All rights reserved. This 
manual or the software described herein, in whole or in 
part, may not be reproduced, translated or reduced to any 
machine readable form without prior written approval 
from Sony Corporation.

SONY CORPORATION PROVIDES NO WARRANTY 
WITH REGARD TO THIS MANUAL, THE 
SOFTWARE OR OTHER INFORMATION 
CONTAINED HEREIN AND HEREBY EXPRESSLY 
DISCLAIMS ANY IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR ANY 
PARTICULAR PURPOSE WITH REGARD TO THIS 
MANUAL, THE SOFTWARE OR SUCH OTHER 
INFORMATION. IN NO EVENT SHALL SONY 
CORPORATION BE LIABLE FOR ANY 
INCIDENTAL, CONSEQUENTIAL OR SPECIAL 
DAMAGES, WHETHER BASED ON TORT, 
CONTRACT, OR OTHERWISE, ARISING OUT OF OR 
IN CONNECTION WITH THIS MANUAL, THE 
SOFTWARE OR OTHER INFORMATION 
CONTAINED HEREIN OR THE USE THEREOF. 

Sony Corporation reserves the right to make any 
modification to this manual or the information contained 
herein at any time without notice.
The software described herein may also be governed by 
the terms of a separate user license agreement.

Material data used for content creation, such as video, 
graphics, and text, may be copyrighted. Unauthorized 
distribution and/or playout of such content may be 
contrary to the provisions of the copyright laws.
Also, the system allows you to use the fonts installed on 
the PC to create text material. Such fonts are copyrighted. 
Authorization or right of transmission is required to use 
them for playout.
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Overview of the System

The Sony BZNP-D1 series Network Player Management 
Software is designed to manage systems that send audio 
and visual contents to Sony NSP-1 Network Players via a 
network and then play those contents, such as sales 
promotional videos at stores or commercial videos in 
public places.
The BZNP-D1 software supports a wide range of display 
sizes from VGA (640 x 480) through XGA (1024 x 768), 
and both landscape and portrait orientation of a display, 
which allows you to use the systems with the maximum 
layout flexibility.
The main tasks of the BZNP-D1 software, such as 
registering materials, and creating playlists and schedules, 
can be performed by simple drag & drop operations.

Materials that the BZNP-D1 Software 
can Handle

The BZNP-D1 software can handle the following 
materials:
• Video: MPEG2 program streams (MP@ML) and 

MPEG4 (ASP@L5)
• MPEG4 live streaming video (conforming to ISMA 1.0): 

MPEG4 live streaming video can be displayed on the 
NSP-1 by specifying the SDP (Session Description 
Protocol) file of a streaming server.

• Graphics: Bitmap and JPEG files
• Web pages: Web pages can be displayed on the NSP-1 

by specifying the appropriate URLs.
• Flash files: Macromedia Flash files
• Audio: Wave and MP3 files
• Text: Captions that you create with the BZNP-D1 

software by specifying the contents, color, font, and 
other attributes.
Text material will be converted to bitmap files before 
being sent to the NSP-1. It is also possible to import a 
bitmap file as a piece of text material.

You can use ordinary files created with conventional 
application software. 

For details, including limitations on each type of material, 
see the supplied SpecsE.htm file.

In addition to the materials listed above, you can use 
external video and audio signals that are input to the NSP-
1 via the VIDEO IN and AUDIO IN connectors, as video 
material, in combination with other materials. 

Operations of the BZNP-D1 Software

The BZNP-D1 software provides the following 
operations:

Making settings required for contents 
distribution
• Registering the NSP-1 players that the BZNP-D1 

manages and creating the required groups
The NSP-1 players are grouped and registered according 
to the contents they play, and the resolution and 
orientation (portrait or landscape) of a display connected 
to the respective NSP-1 players.

• Making screen layout and other settings for each NSP-1 
group

Registering materials to be played on an NSP-1
• Registering materials such as video, graphics, Flash, and 

audio files
• Registering the SDP files for MPEG4 streaming video
• Registering the URLs of Web pages
• Creating and registering text material
• Registering control commands

The BZNP-D1 software provides control commands for 
a PDP (Plasma Display Panel) or other external devices 
connected to an NSP-1. You can also use the control 
commands to adjust the audio volume of an NSP-1. 
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Creating playout schedule for an NSP-1
• Creating playlists (including specifying layout settings)
• Creating a daily schedule

Listing playlists and control commands
• Creating a periodic schedule

Specifying the period when the daily schedule is to be 
used.

Distribution to an NSP-1
• Sending materials, playlists and schedules
• Sending text for overriding content currently being 

played on the NSP-1.
• Checking transfer status
• Checking the NSP-1 status, playout schedules, and 

results (by connecting to the NSP-1 via a network and 
utilizing a web page)

In addition to the above operations, the BZNP-D1 software 
also provides the settings for BZNP-D1 configurations.

On layouts and playlists
The BZNP-D1 software manages an NSP-1 so as to 
display and play respective pieces of material, or a 
combination of materials. 
While editing a playlist, you can specify a combination of 
materials and the position of each piece of material to be 
displayed on a screen as “layout.” 
Order or timing of the materials to be played or other time-
related settings will be defined in a “playlist.”
Unlike other authoring software, the BZNP-D1 software 
manages materials separately, rather than combining them 
onto a timeline to create a piece of video material, and then 
sends them to the NSP-1. The NSP-1 plays the materials 
automatically, according to a playlist, which also includes 
layout information, and schedule data received together 
with the materials. 
This feature allows you to quickly replace some pieces of 
graphics and text materials that are small in data size, or to 
modify the position of video and/or text on the graphics 
material, or produce new combinations of the materials 
simply by sending a new playlist. The system enables you 
to fully utilize your audio and visual contents for flexible 
playout.

For details on layouts and playlists, see “What is a 
Playlist?” on page 35.

On schedules
A “playlist” defines playout order and timing of materials 
in a story, like a TV program. 
In addition to a playlist, the BZNP-D1 software defines a 
“daily schedule” and a “periodic schedule,” which are 
grouped and referred to as a “schedule.”

A “daily schedule” defines the start and end times, in a 
day, of each program (or playlist). A program will be 
played repeatedly in the specified time. 
A “periodic schedule” defines which daily schedule is to 
be used for a specific day. You can create a daily schedule 
and allocate it to each week of a month or to each month 
easily. 

For details on schedules, see “Daily Schedules and 
Periodic Schedules” on page 45.

BZNP-D1 software products

The BZNP-D1 system includes the following types of 
BZNP-D1 software products:
• BZNP-D1LE

Free software that manages only one NSP-1.
• BZNP-D1

A software license for managing up to ten NSP-1 
players. You can increase the number of NSP-1 players 
(up to 210) that the BZNP-D1 software can manage by 
purchasing additional licenses.

• BZNP-DP10
A software license that adds ten more NSP-1 players to 
be managed by the BZNP-D1 software.

• BZNP-DP50
A software license that adds 50 more NSP-1 players to 
be managed by the BZNP-D1 software.

The products differ only in the number of NSP-1 players 
each one can handle, and are identical in features and 
operations.

For detailed operations in registering the licenses and 
increasing the number of NSP-1 players to be managed, 
see “Adding Licenses” on page 19.

Each software package or license can only be used on a 
single PC. The product is offered subject to the supplied 
license agreement displayed upon installation.

Note
7Overview of the System
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Operational Flow

Upon System Installation

The following flowchart shows an example of the 
operations required when the system is installed:

During Routine Operation

The following flowchart shows an example of the routine 
operation of this system after you have finished system 
installation:

Set up the NPS-1 using
web access.

(Refer to the operating
instructions of the NSP-1.)

Make the BZNP-D1 system setup
items.

Specify the material types to
be used.
Specify the video format.

Register the NSP-1 players.

Group the registered NSP-1 players,
and create screen layout templates.

Prepare materials
Register video, graphics, Flash, and audio
files.
Create or register text material.
Register the URL of web pages.
Register additional control commands.

Create playlists (programs)
Specify a destination NSP-1 group, and then
create a playlist for it.
Add materials to a playlist according to the
playout order.

Create a daily schedule
Use a playlist and the control commands of
a PDP or other device to create a schedule.

Specify the playout date (Create a calendar)
Specify the period when the daily schedule
created is to be used.

Transmission
Send a calendar to an NSP-1 group.
Materials, playlists, and daily schedules are
simultaneously transmitted.

Check the transmission status
Check the status of the transmission, if necessary.

Check the NSP-1 status
Check the status of the NSP-1, playout schedules,
and results, if necessary, using a web browser
that can be started from the BZNP-D1 software.
Operational Flow
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For a Simple Operation
in which a Single Playlist is Played 
Repeatedly Everyday

The following flowchart shows an example of a simple 
operation carried out using this system, that is, to 
repeatedly play contents everyday, along with a single 
playlist:

Prepare materials
Register video, graphics, Flash, and audio
files.
Create or register text material.
Register the URL of web pages.
Register additional control commands.

Create a playlist (program)
Specify a destination NSP-1 group, and then
create a playlist for it.
Add materials to a playlist according to the
playout order.

Send as a screen saver
Send the created playlist to an NSP-1 group, as  a
screen saver. All materials used are transmitted
simultaneously.

Check the transmission status
Check the status of the transmission, if necessary.

Check the NSP-1 status
Check the status of the NSP-1 and playout results,
if necessary, using a web browser
that can be started from the BZNP-D1 software.
9Operational Flow
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Operation Windows

Main Window

The major operations of the BZNP-D1 software are 
performed in the following main window. 
Each subwindow will appear or disappear separately with 
the View menu commands. The sub windows can also be 

detached from the main window by dragging the window 
using a mouse, and you can resize detached sub windows.
Double-click the title bar of a detached subwindow to 
return it to its original size and position.

a Menu bar
Provides menus for carrying out the BZNP-D1 tasks. 
By selecting a menu item, commands contained in the 
selected menu are displayed. 

b BZNP-D1 (PC) and NSP-1 (Remote Control) 
option buttons 
Switches the target of operations between the BZNP-
D1 data on the PC and the data on the NSP-1. Usually, 
the BZNP-D1 (PC) option button is selected. 

To check or delete data on the NSP-1, select the NSP-
1 (Remote Control) option button. When this option 
button is selected, the Playlist and Daily Schedule 
windows disappear, and the Content Management 
window expands. The Monthly Calendar window also 
disappears.

c Group or NSP-1 drop-down list box
When the BZNP-D1 (PC) option button is selected, the 
selected NSP-1 group is displayed.

Content Management 
window (see page 11)

2 BZNP-D1 (PC) and NSP-1 
(Remote Control) option buttons 

3Group or NSP-1 drop-down list box 1Menu bar

Playlist window (see page 13)Daily Schedule window (see page 14)
Operation Windows
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When the NSP-1 (Remote Control) option button is 
selected, the selected NSP-1 name is displayed. Use 
the Update button to update the displayed NSP-1 
information. 

You can select the NSP-1 or group here to specify the 
target of the operation.The subwindows display the 
data stored on the location specified by the BZNP-
D1(PC)/NSP-1(Remote Control) option button and 
the Group/NSP-1 drop-down list box.

Content Management Window

To distribute contents, the BZNP-D1 software handles 
source materials such as video, graphics, text, Flash files, 
and URL data of Web pages, playlists, and schedules such 
as daily and periodic schedules. Those data items are 
displayed on the various category tabs in the Content 
Management window, according to their data types. 
The listed items differ depending on the data type. The 
illustration below shows an example when the Video tab is 
displayed. 
Materials and control commands can be used in common 
with all NSP-1 groups. Playlists and schedules are 
managed separately according to NSP-1 groups, hence 

only the playlists and schedules for the selected group are 
displayed. 

 • You can select the data types to be displayed. 
Unnecessary material data will not be displayed, 
depending on the system configuration in effect.

• Data are classified and managed according to the video 
formats (NTSC or PAL). Only data for the format 
selected in the System Setup window are displayed.

For details on system configuration and setup, see 
“Setting Up the BZNP-D1 Software” on page 20.

a Content tab selection buttons
Allows you to choose the data types to be displayed. 
The illustration above shows an example when the 
Video tab is selected and video files registered in the 
BZNP-D1 software are listed.

b Data display area
Shows the data according to the selected content tab 
button. Depending on the data type currently selected, 
list items may differ. 
Data items are displayed in their index order (or in the 
order of registered date for the Periodic Schedule tab) 

Notes

Schedule data

1Content tab selection 
buttons

2Data display area

Material data
(to be used for playlist creation)

Control commands and playlists
(to be used for daily schedule creation)
11Operation Windows
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when the window appears. Clicking a heading row 
cell, such as “Type” or “Title,” rearranges the data 
items according to the clicked item. 
To edit types or titles, select the data you want to 
modify, click its type or title area, edit the text, and 
then press the Enter key.
To delete the data or preview a piece of material on an 
NSP-1, select the desired data, right-click the 
selection, and then select the desired command from 
the popup menu displayed. 

If the material data is displayed in red, its original file 
has been deleted or moved and it is no longer usable. 
When registering material files created with other 
application software, such as video or Flash files, the 
BZNP-D1 software stores the location where the 
original files are saved instead of the files themselves. 
Make sure not to delete, move or edit the original files 
after they are registered with the BZNP-D1 software.

Operations carried out in the Content 
Management window
The Content Management window is used for the 
following operations:
• Checking or editing materials, playlists, and schedules

By double-clicking the data, you can use the BZNP-D1 
editing functions or other application programs 
associated with the data by Windows to check the 
contents. Some associated application programs may 
allow you to edit the contents.

• Selecting the material for playout when creating a 
playlist
With a drag and drop operation, you can add materials to 
a playlist. 

• Selecting playlists to be played and control commands to 
be executed to create a daily schedule
With a drag and drop operation, you can add playlists 
and control commands to a daily schedule.

Note
Operation Windows
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Playlist Window

The Playlist window enables you to combine registered 
materials, such as video, graphics, and text, to create a 
playlist that corresponds to a program. The NSP-1 plays 
out the materials according to the playlist created in this 
window. 
The Playlist window contains columns, each 
corresponding to a layer that the NSP-1 handles.

You can select the layers to be displayed. 
Depending on the template selected, some of the layer 
columns will not be displayed.

For details, see “Making a Screen Layout Template” on 
page 23.

a Window title
Displays the window title “Playlist,” the index (“New” 
in case it has never been saved), and the title of the 
playlist displayed in the window. 

b Playlist
A “playlist” is a list of materials arranged as events in 
layer columns such as “Background,” “Graphics,” and 
“Video,” in the order of playout. In each cell in which 
a piece of material is specified as an event, its title is 
displayed. And the background color of such cells is 
light blue. When you move the mouse pointer over a 
title, a popup window showing the index, type, and 
title of the piece of material appears. 
The “Start Time” column shows the start time of each 
event. Events on the same line will start playing 
simultaneously. 
To create a playlist, drag the desired pieces of 
materials from the Content Management window and 
then drop them onto the list.

To modify the start time or delete an event, right-click 
the desired event and then select the desired command 
from the popup menu.

On the materials for playout and layers
While the tabs in the Content Management window are 
classified according to the formats and type of materials, 
the columns in the Playlist window represent the display 
layers that the NSP-1 handles. 
The table below shows the relationships between material 
types and layers:

Note

1Window title

2Playlist

Start time Event columns

Layers Usage Material to be 
defined

Background Background, wall paper Graphics

Graphics Graphics (with a 
background that is not 
transparent.)

Graphics, URL 
(Web pages), Flash 
files
13Operation Windows
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When a material tab is selected in the Content 
Management window, the background of the layer name 
changes to yellow showing that the data on the tab can be 
assigned to that layer.

For details on NSP-1 layers, see “What is a Playlist?” on 
page 35.

Daily Schedule Window 

In the Daily Schedule window, you can make a daily 
schedule for playout using the created playlists. 
The window also allows you to add control commands to 
the daily schedule, including commands for an NSP-1 or 
an external device, such as a PDP (Plasma Display Panel) 
connected to an NSP-1.

a Window title
Displays the title “Daily Schedule,” the index (“New” 
in case it has never been saved) and the title of the 
daily schedule that is being displayed.

b Daily schedule data 
Displays the daily playout schedule listing the playlists 
in the order of playout. The light blue background 
color of the cell means that there is a playlist or a 
control command specified in it.
The Playlists column shows titles of the playlists to be 
played at the time displayed in the Start Time column. 
In the Control column, the control commands for an 
NSP-1, a PDP, or an external device connected to an 
NSP-1, are displayed with the appropriate marks.

Video Video (with or without 
audio), MPEG4 
streaming video

Video, or video and 
audio input from 
the NSP-1 VIDEO 
IN and AUDIO IN 
connectors

Logo Logotype marks, down-
stream keying (with 
transparent 
background), graphics to 
be displayed over video 

Graphics 

Text Captions Text

Audio Extra-audio Audio

Hint

Layers Usage Material to be 
defined

Marks Corresponding control commands

Control commands for an NSP-1

Control commands for a display or an 
external device connected to an NSP-1 
via an RS-232C interface.

2Daily schedule data

1Window title
Operation Windows
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When you move the mouse pointer over a title or mark, 
a popup window showing the index, type, and title of 
the playlist or control command appears.

The line displayed in red indicates the five-minute 
daily sleeping time reserved for the NSP-1 hard disk. 
As the NSP-1 player cannot be used for playout during 
the sleeping time (and it does not receive any data, 
either), you cannot specify any playlists or control 
commands on this line. 
The NSP-1 stops hard disk rotation for a while, then 
restarts and resumes playout from the beginning of the 
playlist.

If a control command is specified on a line of the daily 
schedule, it will be performed on an NSP-1 or sent to 
an external device at the time specified in the Start 
Time column. If a playlist is defined, playout of the 
playlist starts and continues until the start time of the 
next playlist. If the playout duration of the playlist is 
shorter, playout of the playlist repeats. If the duration 
of the playlist is longer, the playout stops in the middle 
when the next playlist starts playing. 
To change the start time or delete a specified item, 
right-click the desired cell and select the desired 
command from the popup menu. 

Monthly Calendar Window

The Monthly Calendar window is not displayed in the 
main window. When [Monthly Calendar] on the View 
menu is checked, it appears outside the main window.
In the Monthly Calendar window, you can check the 
playout and non-playout days, and the status of the 
periodic schedule for each day. It also enables you to 
create or edit a periodic schedule or send one to the NSP-1.
Note that the Monthly Calendar window displays 
information on the NSP-1 group selected in the main 
window. Therefore, it automatically closes when you 
select the NSP-1 (Remote Control) option button to 
display information on a single NSP-1 player.

a Group indicator
Displays the name of the group currently selected in 
the main window. The Monthly Calendar window 
shows information, such as the status of the periodic 
schedule and playout/non-playout days, on this group.
To check information on another group, select the 
desired group using the Group drop-down list box in 
the main window.

b Year and month drop-down list boxes
Specifies the month to be displayed in the window. 
Selecting a year or a month with the appropriate drop-
down list box switches the displayed month.

c Previous and next month buttons
Selects and displays the previous or next month.

d This Month button
Selects and displays the current month.

Hint

6Current date and time

1Group indicator 2 Year and month drop-
down list boxes

3 Previous and next 
month buttons

4This Month button

5Calendar
15Operation Windows
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e Calendar
Displays the non-playout days in red. The other days 
are displayed in black. 
It also shows the status of the periodic schedule 
specified for each day by the background color. The 
meanings of the background colors are described at the 
bottom of the window.
Pointing to a day for which a periodic schedule has 
been specified with a mouse triggers a popup window 
with detailed information on the periodic schedule.
You can create or edit periodic schedules using the 
menu that appears when you right-click a day on the 
calendar, and you can send the existing ones to the 
NSP-1 players.

f Current date and time
Displays the current date and time.
Operation Windows
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Starting the Software

1 Double-click the short-cut of the BZNP-D1 software 
on the Windows desktop.
Or, select [Start]> [Programs] > [NSP-1 Management] 
< [BZNP-D1].

The BZNP-D1 main window opens, allowing you to 
use the BZNP-D1. 

Exiting the Software

1 Click the [x] (Close) button at the top right of the 
BZNP-D1 main window.

The BZNP-D1 windows close, and the software 
terminates.

If there is an unsaved playlist or daily schedule, the 
BZNP-D1 software asks you whether you want to save 
it. 
Save it, if necessary.

You cannot terminate the software during data 
transmission to a group of NSP-1 players or while 
waiting for a transmission to start.

Even after terminating the BZNP-D1 software, the 
materials sent to an NSP-1 will be played out 
automatically according to the specified playlist and 
schedule.

Note
17oftware / Exiting the Software
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Installation 
Initial System Setup Items

After installation of the software, you need to carry out the 
following system setup operations:
• Adding licenses

Just after installation of the software, the BZNP-D1 
software functions as a BZNP-D1LE that can manage 
only one NSP-1 player. By adding the license keys 
supplied when you purchased the BZNP-D1 retail 
edition or additional licences, you can increase the 
number of NSP-1 players and groups that the BZNP-D1 
software can manage.

• Specifying the BZNP-D1 setup items
Select the video format you want to use. Also select only 
the materials to be used so that you can avoid displaying 
unnecessary materials in the window.

• Registering NSP-1 players to be managed and creating 
their groups
The BZNP-D1 software manages the NSP-1 players by 
their groups. Create NSP-1 groups according to the 
contents the NSP-1 players play, and the resolution and 
orientation (portrait or landscape) of a display connected 
to the NSP-1.

• Setting the template
Based on the screen resolution and orientation, you can 
create a template of the screen layout (layout of the 
materials being displayed simultaneously on the screen). 
By selecting a template when creating a playlist, the 
materials will be displayed according to the specified 
screen layout.

This section only explains the setting items required after 
installation of the software. Make other settings, if 
necessary, to tailor the system to your operations.

For other settings available with the BZNP-D1 software, 
see “BZNP-D1 System Setup Items” on page 66.

You need to set up the NSP-1 players, too, to use the 
system. Make sure to specify the identical settings with an 
NSP-1, where applicable. The settings made in the BZNP-
D1 software will not be reflected on the NSP-1 players.
A web browser is used for NSP-1 setup. See the NSP-1 
operating instructions for details.

Note
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Adding Licenses

Just after installation of the software, the BZNP-D1 
software functions as a BZNP-D1LE that can manage only 
one NSP-1 player. 
Follow the procedure below to enter the master license 
key, and then additional licence key(s) so that you can 
increase the number of NSP-1 players (up to 210) that the 
BZNP-D1 software can manage:

1  In the BZNP-D1 main window, select [Help] > 
[License Settings] from the menu bar. 

The License Settings dialog box is displayed.

2 To enter the BZNP-D1 license key (master license 
key), enter the license key data in the Master License 
text box.

To enter an additional license key of the BZNP-DP10 
(for 10 additional NSP-1 players) or the BZNP-DP50 
(for 50 additional NSP-1 players), click [Add 
License], enter the data in the displayed Additional 
License Setting dialog box, then click [OK].
If you enter both the master and additional license keys 
at the same time, enter the master license key before 
clicking [Add License].

The license key you enter is displayed in the 
Additional Licenses list box. The number of available 
NSP-1 players changes accordingly.

Though you can enter only one master license key for 
a BZNP-D1, more than one additional license key can 
be entered. To do so, repeat step 2.

3 Click [OK] in the License Settings dialog box.

Number of NSP-1 players that the 
BZNP-D1 software can manage.

Hint
19Adding Licenses
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Setting Up the BZNP-D1 
Software

In the System Setup window, you need to select the video 
format and the types of material you intend to use for 
content production. By selecting material types, you can 
ensure that only the materials you need are displayed in the 
operation windows.

1 In the BZNP-D1 main window, select [Setup] > 
[System Setup] from the menu bar. 

The System Setup dialog box is displayed.

2 Select the Content Management tab, if it has not been 
selected.

3 If there is any material that is not to be used, clear the 
check box for that material.

In the Content Management window, only the 
materials that you check in this dialog box are 
displayed. 
If you are not going to use video files, for example, 
clear the Video check box so that the Video tab will 
not be displayed in the Content Management window.

4 In the Video drop-down list box, select the video 
format you intend to use (NTSC or PAL).

5 If necessary, change the Base Folder.

The “Base Folder” is the folder where the BZNP-D1 
data will be saved. In normal operations, do not 
change this setting. For details, see “BZNP-D1 System 
Setup Items” on page 66.

6 Click [OK].

The settings that were changed are saved and the 
System Setup dialog box closes. 

For other setting items in the System Setup dialog box, 
see “BZNP-D1 System Setup Items” on page 66.

Items Materials

Video MPEG2 or MPEG4 video files, or MPEG4 
live streaming video 

Graphics BMP or JPEG files 

Text Captions created with the BZNP-D1 
software

URL URLs of the Web pages

Flash Flash files created with Macromedia 
Flash

Audio WAV or MP3 files

Control Control commands for an NSP-1, a PDP 
(plasma display panel), or another 
external device connected to the NSP-1. 
These are added to a Daily schedule.

Items Materials
Setting Up the BZNP-D1 Software
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Registering an NSP-1 and 
Creating Groups 

As the BZNP-D1 software manages an NSP-1 via a 
network, the NSP-1 players to be managed should be 
registered in advance. If an NSP-1 uses a password for 
access management, you should also specify the password 
to be sent from the BZNP-D1 software upon accessing the 
NSP-1. 
And, as the BZNP-D1 software manages playlists and 
schedules for the NSP-1 groups and sends data to these 
groups, you should also create NSP-1 groups. A single 
NSP-1 can be a member of more than one group. Classify 
the NSP-1 players into groups according to the contents 
they play, and the screen resolution and orientation 
(portrait or landscape) of the displays connected to the 
respective NSP-1 players.

Although the BZNP-D1LE supports only one NSP-1 
player, create a group to specify screen orientation and 
resolution, or other group attributes.

1 In the BZNP-D1 main window, select [Setup] > 
[Group Setup] from the menu bar. 

The Group Setup dialog box is displayed.

2 Register the NSP-1 players used in the system.

2-1 Click [New NSP-1].
The Edit NSP-1 dialog box is displayed.

2-2 In the NSP-1 Name and IP Address text boxes, 
enter the name and IP address of an NSP-1.
A password has been set for each NSP-1 player 
when it is shipped from the factory. If you 
change the password, input an identical 
password in the Password and Retype Password 
text boxes and click [OK] to avoid miss-typing.
Make sure to use the IP address and password 
specified for the NSP-1 hardware. Click [Check 
Connection] to test the connection to the 
specified IP address and display the result.

2-3 Repeat steps 2-1 and 2-2 to register all the NSP-
1 players you use in the system.
The registered NSP-1 players will appear in the 
NSP-1 list box in the Group Setup dialog box.

3 The order of the registered NSP-1 players in the Group 
Setup dialog box represents the actual order of the 
NSP-1 players when data is sent or when they are 
being displayed in the NSP-1 Status window. 
Arrange the order of the NSP-1 players as desired 
using drag & drop operations.

4 Create NSP-1 groups.

4-1 Click [New Group].
The Edit Group dialog box is displayed.

4-2 Specify the following items and then click [OK].
Group Name: the name of a group you create.
Screen Resolution (WxH): the resolution of the 
display used.
When you have selected “Composite” for 
“Display” on the NSP-1 System Settings page, 
that has been viewed using a web browser, select 

Note
21Registering an NSP-1 and Creating Groups



22

  C
hapter 3  S

etup R
equired upon Installation
“VGA” here. 
Screen Orientation: the orientation (landscape 
or portrait) of the display used. 
Use the identical screen resolution and 
orientation for each player within a group.

For other items in the Group Setup dialog box, see 
“Setting Items upon Group Registration” on page 
71.

4-3 Repeat steps 4-1 and 4-2 to register all the 
necessary groups.
The registered groups will appear in the Group 
list box in the Group Setup dialog box.

5 The order of the groups in the Group Setup dialog box 
represents the actual order of the groups when they are 
displayed as options in the BZNP-D1 software. 
Arrange the order of the NSP-1 groups as desired 
using drag & drop operations.

6 Assign each NSP-1 registered in step 2 to a group.

6-1 Click to select the desired group in the Group list 
box.

6-2 Select the NSP-1 in the NSP-1 list box.
6-3 Click [Add>>].
6-4 Repeat the above steps to assign all the NSP-1 

players to their proper groups.

7 After you finish registering NSP-1 players, creating 
groups, and assigning NSP-1 players to the groups, 
click [x] at the top right of the Group Setup dialog box.

For detailed operations to change and delete settings, see 
“Detailed Registering and Editing Operations for an NSP-
1 or Group” on page 68.

You cannot change the screen resolution and orientation 
settings if a playlist or schedule has already been created 
for the group. Delete all the playlists, and daily and 
periodic schedules before changing these settings, or 
create another group.
And, when a playlist and/or daily schedule is displayed in 
the respective windows, you cannot change the screen 
resolution and orientation settings, either. Clear the 
settings first by selecting [Playlist] > [New] or [Daily 
Schedule] > [New] before changing them.

NSP-1 player registered 
to the selected group Selected group

NSP-1 players that are not 
registered to the selected group

Note
Registering an NSP-1 and Creating Groups



  C
hapter 3  S

etup R
equired upon Installation
Making a Screen Layout 
Template

You can specify the screen layout settings for the materials 
being played simultaneously on the screen as a template, 
for each set of the screen resolution and orientation. By 
selecting the created template when creating a playlist, the 
materials will be displayed according to the layout settings 
specified in this section.

1 In the BZNP-D1 main window, select [Setup] > 
[Group Setup] from the menu bar. 

The Group Setup dialog box is displayed.

2 Double-click the group whose screen resolution and 
orientation are the same as the layout settings you want 
to specify in the Group list box.
Or, right-click the desired group and select [Edit 
Group] from the popup menu displayed.

The Edit Group dialog box is displayed.

3 Click [Template Settings].

The Screen Layout window corresponding to the 
resolution and orientation specified for the selected 
group, and the Template Settings dialog box are 
displayed. 

• The numbers assigned to each layer in the Screen 
Layout window shown above indicate the overlaid 
order of the layers.
The Background layer(1) is laid out at the bottom 
and the Text layer(5) is at the top.

• Clicking any point in the Screen Layout window 
displays a popup menu. [View: 50%] and [View: 
100%] on the menu change the Screen Layout 
window size.

4 Select the layers to be used for the selected group.
Among the layers shown below, clear the check box of 
the layer(s) in the Template Settings dialog box that 
you will never use.
 

Hints

Layers Usage Material types 
to be defined

Background Background, wall paper Graphics

Graphics Graphics (with the 
background that is not 
transparent.)

Graphics, URL 
(Web pages), 
Flash files

Background layer(1)Graphics layer(2)

Video layer(3)

Logo layer(4)

Text layer(5)

Screen Layout window

Template Settings dialog box
23Making a Screen Layout Template



24

  C
hapter 3  S

etup R
equired upon Installation
In the Playlist window, only the layers having check 
marks in this dialog box are displayed. 
If you are not going to use the video layer, for 
example, clear the Video check box so that the video 
layer will not be displayed in the Playlist window.
If you clear a check box, the relevant layer in the 
Screen Layout window will disappear.

5 Specify the sizes and positions of layers to be used.
Do the following for all the layers, respectively.

• Click the layer in the Screen Layout window, then 
select a handle of the layer and drag it to the desired 
position and size.
When you click any point in the Template Settings 
dialog box, the values change according to the 
position and size of the layer in the Screen Layout 
window. 

• Select the layer in the Screen Layout window, right-
click it, then select [Full-Screen Size], [Quarter-
Screen Size] or [Original Size].
[Full-Screen Size] and [Quarter-Screen Size] can be 
used for the Graphics, Video, and Logo layers. 
[Original Size] can be used only for the Video layer, 
and it restricts the layer size to 640 x 480 (or 480 x 

640) pixels.
When you click any point in the Template Settings 
dialog box, the values change accordingly.

• Change the values of the relevant text boxes in the 
Playlist Layout Settings dialog box.
By changing values and clicking any point in the 
Screen Layout window, the position and/or size of 
the layer(s) in the Screen Layout window change 
accordingly.

• For the Graphics, Video, and Logo layers, you can 
keep the aspect ratio of the layers identical to that of 
the material file assigned in the playlist upon 
changing layout, by placing check marks in the 
Original Aspect Ratio check boxes.
Note that, however, for layers other than the Video 
layer, the layout changing procedure is required 
during playlist editing to make the aspect ratio of the 
layers identical to those of the material files. 
Otherwise, contents will be shown in the aspect ratio 
of the layers, not of the material files. And, for web 
pages affixed on the Graphics layer, this setting will 
not work, as the BZNP-D1 software cannot obtain 
the size and shape of the original web pages.
For the Video layer, the aspect ratio will be 4:3 (or 
3:4 if the screen orientation set is “Portrait”) 
regardless of the aspect ratio of the original video.

6 Click [Add] in the Template Settings dialog box, then 
enter the name of the template on the newly added line 
in the Template drop-down list box.

The settings are saved as a template.

7 Click [OK] in the Template Settings dialog box.

The Screen Layout window and the Template Settings 
dialog box close. 

8 Return to step 2 and make settings for another set of 
screen resolution and orientation.
Or, return to step 3 and make another template. 

• You cannot change the overlaid order of the layers. 
• The Background layer is always displayed in full-screen 

size.
• Note that, when you use more than one template in a 

playlist, the BZNP-D1 software only saves the events on 
the layers that are used in the template at the time of 
saving. It is recommended that you keep layers which 
you may use. The layers will affect playout only when a 
piece of material is specified as an event.

• Depending on the screen orientation (landscape or 
portrait), and the combination and overlapping of the 
layers used, the NSP-1 may not be able to display the 
contents according to the specified layout. After you 
finish creating a playlist, make sure to check if the 

Video Video (accompanied 
with audio), MPEG4 
streaming video

Video, 
video and 
audio input 
from the 
VIDEO IN and 
AUDIO IN 
connectors

Logo Logotype marks, down-
stream keying (with 
transparent 
background), graphics 
to be displayed over 
video 

Graphics

Text Captions Text

Audio Extra-audio Audio

Layers Usage Material types 
to be defined

Handle

Notes
Making a Screen Layout Template
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materials are displayed as intended by previewing the 
playlist on the NSP-1.

For information on how to preview a playlist, see 
“Checking Playout (Previewing on an NSP-1)” on page 
53.
25Making a Screen Layout Template
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Material Preparations

The BZNP-D1 software accepts the following materials as 
playout contents:

Materials created with other application software
• Video clips (including announce (SDP) files of MPEG4 

streaming video clips)
• Graphics (still images)
• Flash files
• Audio files
Register such files in the BZNP-D1 as materials to use 
them.

For details on specifications and limitations on files to be 
used as materials, see the supplied SpecsE.htm file.

Material created with the BZNP-D1 software
• Text (captions)
Create text material by specifying the color, font, text size, 
and entering text with the BZNP-D1 software. You can 
also import text files instead of typing them.

Bitmap files can also be registered as text material instead 
of typing the text itself. This feature is useful when you 
would like to use a caption with special effects.

Other materials
• Web pages
• Control commands
Register the URL of each web page you want to display 
using the NSP-1.
For control commands, the BZNP-D1 software provides 
some control commands for the NSP-1 and for some of the 
plasma displays, whose operations in combination with the 
NSP-1 have been confirmed. You can also add other 
commands.

Registering Video, Graphics, Flash 
and Audio Files

This section explains how to register material files that 
have been created with other application software in the 
BZNP-D1 software.

The following procedure registers the place where a 
material file (actual file) is stored, together with the title 
and type data of that material.
Never move, delete, or edit the actual file after registration. 
If you do so, the BZNP-D1 software may not be able to 
send the corresponding material to the NSP-1 and this will 
result in playout failure.
And, to register material files recorded on a CD or DVD, 
it is recommended that you copy those files to the hard disk 
of the PC before registering them. Directly registering files 
on a CD or DVD may cause a read error, depending on the 
drive you use, and result in a failure when sending 
materials. 

1 Select [Tools] > [Run Explorer] on the menu bar to 
start the Windows Explorer, if this has not yet been 
done.

2 In the Explorer window, locate the folder where the 
files you want to register are stored.

3 In the BZNP-D1 Content Management window, select 
the tab corresponding to the category of the material to 
be registered.

Hint

Note
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4 Select the files to be registered.
You can register more than one file simultaneously, 
provided they are in the identical category.
To select more than one file, hold down the Ctrl key 
and click the desired files in turn.
To select all the files in a range, hold down the Shift 
key and click the first and last files in the range.

5 Move the selected files from the Explorer window to 
the BZNP-D1 window by a drag & drop operation.

The new material is added in the Content Management 
window.
The names of the files are shown as the titles, and the 
date of registration is shown in the date last modified 
column.

6 Edit the types and titles of the registered material, if 
necessary.
Select a line, then click its Type or Title column, 
specify the type (up to 20 characters) or title (up to 40 
characters), and then press the Enter key.

On registration of an announce file (SDP file) for 
MPEG4 streaming video
NSP-1 players and the BZNP-D1 software support 
MPEG4 live streaming video. Playing a live streaming 
video on an NSP-1, unlike a normal video file whose 
playout starts from the beginning of the file, consists of 
displaying the contents played on the streaming server at 
that time, just like video and audio input to the VIDEO IN 
and AUDIO IN connectors of the NSP-1.
To register such a streaming video as a piece of video 
material, the following operation is required:

1 Add the announce file (an SDP file with the .m4e file 
extension) on the Video tab of the Content 
Management window using a drag & drop operation.

Ask your supplier or Sony sales representative for 
details on how to obtain the appropriate announce file, 
as it varies depending on the streaming server used.

A new piece of video material appears in the Content 
Management window. “Live Streaming” is displayed 
in the Type column, and “00:00:00” is displayed in the 
Duration column.

2 To specify the material duration, select the piece of 
material, then click its Duration column. This makes 
the column editable. Specify the desired duration, and 
then press the Enter key.
You can also leave the material duration as 
“00:00:00,” and specify the desired event duration 
after listing this streaming video in a playlist as an 
event.

To modify the duration of a video clip or Flash 
movie
When you drop a video clip or Flash file in the Content 
Management window, the BZNP-D1 checks its duration 
and displays it in the Duration column. You can modify 
this duration by selecting the line then clicking the 
Duration column, in the same way as the type and title 
columns.
Modification of the duration is useful in the following 
cases, when the actual duration and that the BZNP-D1 
software obtains are different:
• Duration shown in the Content Management window is 

“00:00:00.”
The BZNP-D1 software may not recognize the duration 
of a video clip when there is no DirectShow filter 
installed on the PC where the BZNP-D1 software is 
operating. It may not recognize the duration of a Flash 
movie, either, depending on the condition in effect when 
the Flash movie was created.

• The last few frames are not played.
As the BZNP-D1 software manipulates the materials in 
units of seconds, the very last frames of a video clip or 
Flash movie will not be played if there is a fraction in the 

Content tab selection buttons
27Material Preparations
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actual playout length.
You can modify the duration of the piece of video or 
Flash material, in such a case, to play it entirely. But a 
frozen picture of the last frame may be displayed at the 
very end.

You can also leave the material duration as “00:00:00,” 
and add the piece of material to a playlist. In such a case, 
the shortest event duration “00:00:05” is specified for the 
event. You can modify the event duration as desired.

When no DirectShow filter is installed, the BZNP-D1 
software cannot recognize the video signal format (NTSC 
or PAL) and display size of the video files. Also, the video 
signal format of MPEG4 files cannot be recognized even if 
a DirectShow filter is installed.
If the video signal format of the video clip and that of the 
system setup are not identical, the video clip will not be 
played correctly. 

To check the material content
The BZNP-D1 software provides two ways to check the 
material content; playing a piece of material on the PC, and 
sending it to an NSP-1 and playing it on the NSP-1.

For detailed information on how to play material on a PC, 
see “Checking Material on a PC (Previewing)” on page 
34.
For information on how to play material on an NSP-1, see 
“Checking Playout (Previewing on an NSP-1)” on page 
53.

To delete material
Right-click the piece of material to be deleted in the 
Content Management window, then select [Delete] on the 
popup menu.
Or, select the piece of material to be deleted, then press the 
Delete key on the keyboard.
When a confirmation message appears, click [Yes].

This deletion operation for video, graphics, Flash, and 
audio materials only deletes material registrations. The 
actual files are not deleted.
To delete the actual files, too, use the Windows Explorer.

Creating Text Material

Specify the text, colors, font, size, and effects to be 
displayed to create text material.

The BZNP-D1 software enables you to register a bitmap 
file instead of text as a piece of text material.

See “Registering a bitmap file as text material” on page 30 
for details.

1 Select the Text tab in the Content Management 
window.

2 Right-click any point on the Text tab, then click 
[New].

The Edit Text dialog box appears.

3 Click [Properties] to open the Text Properties dialog 
box.

4 Specify the following properties, then click [OK].

Note

Note

Hint
Material Preparations
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The Text Properties dialog box closes.

5 Select the desired font and character size with the Font 
and Font Size dialog boxes in the Edit Text dialog box.

6 Type the desired text.
You can also copy text from another application 
program such as a word processor, and paste it in the 
Edit Text dialog box by pressing the Ctrl+V keys.
To import a text file, click [Read Text File] and specify 
the file.

7 Click [OK].

The newly created piece of text material appears in the 
Content Management window.

To change the color of the text
Whereas the base color of the text is selected by clicking 
[Change Character Color] in the Text Properties dialog 
box, the following procedure changes the color of a part or 
of the entire piece of text that has already been typed.

1 Select the text for which you want to change the color 
by dragging the mouse in the Edit Text dialog box, 
then right-click the selection.

2 Select [Change Character Color] on the popup menu.

The Text Color Settings dialog box appears.

3 Select the desired color in the Text Color Settings 
dialog box, then click [OK].

You can replace a color displayed in the Text Color 
Settings dialog box with a new one by clicking [Change 
Color], then selecting the color in the Edit Colors dialog 
box.

To select a style for the text

1 The BZNP-D1 software enables you to assign bold, 
italic, and underlined styles to a part or to the entire 
piece of text.

2 Select the text to which you want to assign styles by 
dragging the mouse in the Edit Text dialog box, then 
right-click the selection.

3 Click [Font Style] on the popup menu, then click the 
command corresponding to the desired style on the 
cascading menu.
To remove the specified style from the text, click the 
command corresponding to the style to be removed (it 
has a check mark) in the same way, or click [Regular].

The BZNP-D1 software allows only one font (font face 
and size) within a single piece of text material.

To modify text material
Right-click the line of the piece of text material to be 
modified in the Content Management window, then click 
[Edit] on the popup menu. This opens the Edit Text dialog 
box containing the content of the selected piece of text 
material. Modify the text and/or properties, then click 
[OK].

Item Description

Type Type of the piece of text 
material (up to 20 characters).

Title Title of the piece of text 
material (up to 40 characters). 
When no title is specified, the 
first 40 characters of the text 
will be the title.
You can identify pieces of 
materials by the type and title.

Effect Select the text display effect 
from the following:
Constant: Displays stable text.
Blink: Displays blinking text.
Scroll: Makes text flow across 
the display from right to left.

Scroll speed Select the speed of text flow, 
when you select “Scroll” for 
“Effect.”
Note that the scroll speed 
settings of BZNP-D1 version 
1.0 and version 2.0 are 
different.

Transparency
(Not selectable in this 
version)

Select whether the background 
color should be transparent or 
not.

Base character color The square shows the current 
text color. To change it, click 
[Change Character Color] and 
select the desired color in the 
Edit Colors dialog box.
To change the color of the text 
that has already been typed in 
the Edit Text dialog box, right-
click the text and select 
[Change Character Color].

Background color The square shows the current 
background color. To change it, 
click [Change Background 
Color] and select the desired 
color in the Edit Colors dialog 
box.
The background color cannot 
be changed partially.

Hint

Note
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To just modify the type and/or title, select the piece of 
material, then click its Type or Title column. This makes 
the column editable. Specify the type (up to 20 characters) 
or title (up to 40 characters), and then press the Enter key.

The scroll speed corresponding to each option in the Text 
Properties dialog box has been changed in the BZNP-D1 
version 2.0 software.
Note that, if you edit any piece of scrolling text material 
created using version 1.0, the speed will be changed to 
“Slow” (equals “Medium” in version 1.0) automatically.
Select the desired speed using the Scroll Speed drop-down 
list box in the Text Properties dialog box, if necessary.

To check text material
You can send a piece of text material to an NSP-1 and play 
it on the NSP-1.

For information on how to play material on an NSP-1, see 
“Checking Playout (Previewing on an NSP-1)” on page 
53.

To delete text material
Right-click the piece of text material to be deleted in the 
Content Management window, then select [Delete] on the 
popup menu.
Or, select the piece of text material to be deleted, then 
press the Delete key.
When a confirmation message appears, click [Yes].

Registering a bitmap file as text material
Instead of typing text, the following procedure registers a 
bitmap file to the BZNP-D1 software as a piece of text 
material. This feature is useful when you would like to use 
a caption with special effects.

There are some limitations that are different from those for 
the bitmap files used as graphics material, for bitmaps files 
used as text material.
Note that, if the NSP-1 transparent color is used in the 
bitmap file, the area of that color will be transparent, 
regardless of the Transparency option of the Text 
Properties dialog box. 

For details on specifications and limitations on files to be 
used as text material, see the supplied SpecsE.htm file.

1 Select [Tools] > [Run Explorer] on the menu bar to 
start the Windows Explorer, if this has not yet been 
done.

2 In the Explorer window, locate the folder where the 
bitmap files you want to register are stored.

3 In the BZNP-D1 Content Management window, select 
the Text tab.

4 Select the bitmap files to be registered.
You can register more than one file simultaneously.
To select more than one file, hold down the Ctrl key 
and click the desired files in turn.
To select all the files in a range, hold down the Shift 
key and click the first and last files in the range.

5 Move the selected files from the Explorer window to 
the BZNP-D1 window by a drag & drop operation.

The new material is added in the Content Management 
window.
The names of the files are shown as the titles, and the 
date of registration is shown in the date last modified 
column.

6 Right-click the new pieces of text material, 
respectively, and click [Edit] on the popup menu.

The Edit Text dialog box appears.

7 Click [Properties], specify the following properties in 
the Text Properties dialog box, as necessary, then click 
[OK].

Note

Note
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The Text Properties dialog box closes.

8 Click [OK] in the Edit Text dialog box.

9 Repeat steps 6 through 8 to specify the properties for 
each added piece of text material.

The BZNP-D1 software only allows you to modify the 
items in the Text Properties dialog box after the bitmap file 
is registered as text material. To replace the bitmap, create 
a new piece of text material and discard the unnecessary 
one.
You can send this material and play it on an NSP-1 to 
check it, and you can delete this material just like normal 
text material.

Registering the URL of a Web Page

The BZNP-D1 enables you to use web pages as material to 
be displayed using an NSP-1. To use a web page, register 
its URL as a piece of material using the following 
procedure.

1 Select the URL tab in the Content Management 
window.

2 Right-click any point on the URL tab, then select 
[New] on the popup menu.

A line is added to the list on the URL tab, and its 
address column becomes editable.

3 Enter the URL of the desired web page (up to 255 
characters), then press the Enter key.
You can also copy a URL from a web browser, and 
paste it here by pressing the Ctrl+V keys.

4 Enter the type and title of the registered web page.
Select the line, then click its Type or Title column, 
specify the type (up to 20 characters), or title (up to 40 
characters), and then press the Enter key.

To register a shifted web page
The BZNP-D1 software provides a “Shift Page Origin” 
command for web page material.
This feature is useful when you would like to display a 
specific part of a web page, cropping the top and left menu 
area, for example. Specifying “100 pixels” as the shift 
amount for both X and Y respectively, for example, crops 
100 pixels each from the top and from the left side of the 
web page when it is displayed. 

1 Right-click the web page data to be cropped on the 
URL tab of the Content Management window, and 
select [Shift Page Origin] on the popup menu.

The Shift Page Origin dialog box appears.

Item Description

Type Type of the piece of text 
material (up to 20 characters).

Title Title of the piece of text 
material (up to 40 characters). 
You can identify pieces of 
materials by the type and title.

Effect Select the text display effect 
from the following:
Constant: Displays stable text.
Blink: Displays blinking text.
Scroll: Makes text flow across 
the display from right to left.

Scroll speed Select the speed of text flow, 
when you select “Scroll” for 
“Effect.”
Note that the scroll speed 
settings of BZNP-D1 version 
1.0 and version 2.0 are 
different.

Transparency (Not selectable in this version)

Note

100 pixels

Cropped 100 pixels
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2 Enter the number of pixels to be cropped from the left 
side (X) and from the top (Y), then click [OK].

The displayed web page will shift only when the web page 
is larger than the size of the Graphics layer on which the 
web page is displayed.
For example, when the web page is 400 x 400 pixels and 
the Graphics layer is 300 x 300 pixels, the maximum shift 
possible for this web page is 100 pixels for both X- and Y-
coordinates, even if you specify a larger number in the 
Shift Page Origin dialog box. To shift the page more, in 
such a case, make the graphics layer size smaller for the 
event on the playlist.
And, note that a web page will not shift if you specify a 
URL corresponding to a frame set. HTML structure issues 
cause this. Specify the URL corresponding to the desired 
frame, instead.

To modify web page material
Select the web page data to be modified, then click its 
Type, Title, or Address column. This makes the clicked 
column editable. Modify the type (up to 20 characters), 
title (up to 40 characters), or URL (up to 255 characters), 
and then press the Enter key.

To check a registered web page
Double-clicking registered web page data in the Content 
Management window starts the web browser associated 
with web pages, such as Internet Explorer or Netscape 
Navigator, and displays the selected web page. Or, you can 
send the data to an NSP-1 and display the web page using 
the NSP-1.

For detailed information on how to check the material on 
a PC, see “Checking Material on a PC (Previewing)” on 
page 34.
For information on how to play material on an NSP-1, see 
“Checking Playout (Previewing on an NSP-1)” on page 
53.

To delete registered web page material
Right-click the web page data to be deleted in the Content 
Management window, then select [Delete] on the popup 
menu.
Or, select the web page data to be deleted, then press the 
Delete key.
When a confirmation message appears, click [Yes].

Note
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Registering Additional Control 
Commands

By sending a control command to an NSP-1, the following 
types of controls are available:
• Control of an external device, such as a plasma display 

or projector, via an RS-232C connection.
• Control of the output audio level of an NSP-1.

Unlike other materials, these control commands are not 
specified in the playlists, but they can be included in the 
daily schedules together with the playlists. You can also 
send them to an NSP-1 to manually control the NSP-1 
itself or the connected device.

Some commands for the NSP-1 and Sony’s plasma 
displays whose operations have been confirmed in 
combination with the NSP-1 are provided with the BZNP-
D1 software. The following procedures add more control 
commands.

• Refer to the protocol manual of the plasma display for 
details on its control commands. Ask your supplier or 
Sony sales representative about the protocol manual.

• For information on the control commands of a third 
party’s display or other device, ask the sales 
representative of the device.

• Supplied control commands which have index numbers 
of x07999000 or greater, cannot be deleted. If you make 
modifications on such a control command, it is saved 
with a new index number.

1 Select the Control tab in the Content Management 
window.

2 Right-click any point on the Control tab, then select 
[New] on the popup menu.

The Edit Control dialog box appears.

3 Specify the following items in the Edit Control dialog 
box, then click [OK].

The Edit Control dialog box closes.
The new control command appears in the Content 
management window.

To modify control commands
Right-click the line of the control command to be modified 
in the Content Management window, then click [Edit] on 
the popup menu. This opens the Edit Control dialog box 
containing the content of the selected control command. 
Modify the data, then click [OK].
To just modify the type and/or title, select the control 
command in the Content Management window, then click 
its Type or Title column. This makes the column editable. 

Notes

Item Description

Type Type of the control command (up to 20 
characters).

Title Title of the control command (up to 40 
characters). You can identify the 
control commands by the type and 
title.

Target Select the target from the following:
• NSP-1 Audio Output Level

Controls the audio output level of the 
NSP-1.

• Via RS-232C Port
Controls the device connected to the 
NSP-1 RS-232C connector, such as 
a plasma display or projector.

Parameter-1, 
Parameter-2

Specify a code corresponding to the 
desired control.
• NSP-1 Audio Output Level

Specify the desired audio level (0 
through 100(%)) in the Parameter-1 
text box. The Parameter-2 text box is 
not used.

• Via RS-232C Port
Specify the hexadecimal code of the 
command to be sent in the 
Parameter-1 text box. In the 
Parameter-2 text box, a hexadecimal 
code corresponding to “ACK” to be 
sent from the device as return data 
is specified. The NSP-1 records an 
error in its error log if the return data 
is not identical with the specified 
code.
The Parameter-2 text box should be 
blank if the connected device will not 
return any data. An NSP-1 will retry 
sending a command until it receives 
return data, hence a problem may 
occur if the device returns nothing.
Specify the code, in either text box, 
separated every two digits by a 
space character. Do not omit “0”s, if 
any.
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Specify the type (up to 20 characters), or title (up to 40 
characters), and then press the Enter key.

To check a control command
You can send a control command to an NSP-1 and try it on 
the NSP-1.

For information on how to check the material on an NSP-
1, see “Checking Playout (Previewing on an NSP-1)” on 
page 53.

To delete a control command
Right-click the control command to be deleted in the 
Content Management window, then select [Delete] on the 
popup menu.
Or, select the control command to be deleted, then press 
the Delete key.
When a confirmation message appears, click [Yes].

Checking Material on a PC 
(Previewing)

The following materials can be previewed on a PC to 
check their contents. The application programs that are 
associated with the materials in Windows are used for 
previewing.

Some materials require additional plug-in software, such 
as a DirectShow filter, for previewing on a PC.

1 Select the tab for the material to be previewed in the 
Content Management window.

2 Double-click the piece of material to be previewed.

A window of the application program associated with 
the material opens, and the selected piece of material 
is played.

Material played on the PC may be different from the actual 
playback on an NSP-1.
To check materials precisely, send the data to an NSP-1, 
and preview the materials on it.

For information on how to preview materials on an NSP-
1, see “Checking Playout (Previewing on an NSP-1)” on 
page 53.

Note

Material Application program to be used

Video Video player, such as Windows Media Player.

Graphics Image viewer, such as Windows Picture and 
Fax Viewer.

URL Web browser, such as Internet Explorer.

Flash Macromedia Flash Player.

Audio Audio player, such as Windows Media Player.

Note
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Playlist Preparations

To play back the desired contents on an NSP-1, you need 
to prepare “playlists” that specify the order and 
combinations of materials and “schedules” that identify 
the time and date when a playlist will be used, together 
with the materials, such as video and text files.
The “schedules” contain both “daily schedules” and 
“periodic schedules.”

What is a Playlist?

The NSP-1 has six layers, and the six types of material that 
the BZNP-D1 software manages are played on the 
designated layers, respectively.
The “playlists” describe the order of material to be played 
on each layer. An NSP-1 automatically plays materials on 
the respective layers, according to the playlist.
Materials that appear on the same line of the playlist will 
be played simultaneously on the NSP-1. The positions and 
sizes of these materials are designated as “layout” and 
saved in the playlist.

Playout order
The following figure shows an example of a playlist.

The leftmost Start Time column displays the start time of 
each line. This is counted from the start time of the playlist.
Then, there are columns corresponding to the NSP-1 
layers, and the events (material) that will be played on the 
layer are specified in the cells. An event is a piece of 
material specified in a cell on the playlist. The color of a 
cell in which an event is specified is light blue.
Events specified on the same line will be started 
simultaneously at the time specified in the Start Time 
column.

Layout settings
“Layout” designates the positions and sizes, on the display, 
of the contents of the events that are listed on the same line.
The following table shows the NSP-1 layers and the 
materials to be played on the respective layers.
Note that graphics material can be played on any of the 
background, graphics, or logo layers, and that web page 
and Flash movie materials are played on the graphics layer.

Upon playout, the layers (except for the audio layer) are 
overlaid in the order shown in the following figure.

The layout settings (the sizes and positions of the layers) 
can be adjusted by using the Layout Settings command 
that is shown when you right-click a line (except for the 
Audio layer column) of the playlist.

The order of overlay cannot be changed.

Playout order

Start time Layers on an NSP-1

Layout settings

Layer Materials played
Background Graphics

Graphics Graphics, URL (Web pages), Flash movies:
displayed under the video layer.

Video Video, MPEG4 streaming video, video signal 
input via the NSP-1 VIDEO IN connector 
(with accompanying audio input via the 
AUDIO IN connector)

Logo Graphics:
displayed in front of the video layer.

Text Text

Audio Audio

Note

Graphics (2) Logo (4) Video (3)

Text (5)

Background (1)
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The differences between the background, 
graphics and logo layers
Any of the background, graphics, or logo layers can 
display graphics content. Select one of them according to 
your purpose as follows:
The background layer is at the back, as shown in the figure 
above, and used to display graphics such as wallpaper. 
When you specify a piece of graphics material to be 
displayed on the background layer, it appears in full-screen 
size regardless of the original material size.
The graphics layer is under the video layer, and is used to 
display a still image or a web page. A Flash movie is also 
played on this layer.
The logo layer is mainly used for downstream keying, that 
is, to display a mark, such as a program, station, or 
company logo mark, constantly on the display. The logo 
layer is in front of the video layer, and the NSP-1 
transparent color will be transparent on this layer.

On templates
The BZNP-D1 software provides a “template” feature to 
reduce time and effort needed to specify layout settings for 
every event on the playlist. A template is a set of layout 
settings that can be saved in the BZNP-D1 software. When 
changing the layout, one of the templates is chosen, then 
the layout settings of that template are automatically 
specified for the events thereafter, and recorded in the 
playlist. 
Templates are also useful when you want to apply the same 
layout settings to more than one playlist.
You can adjust the positions and sizes of the materials laid 
out by a template later. 

See “Making a Screen Layout Template” on page 23 for 
details on how to create a template.

Exceptions to layout settings
There are the following exceptions to the layout settings, 
whether you adjust the layout settings later or not:
• The text contents will be displayed in their original size, 

regardless of the specified text layer size. 
• Depending on the screen orientation (landscape or 

portrait), and the combination and overlapping of the 
layers used, the NSP-1 may not be able to display the 
contents according to the specified layout. To precisely 
check the playout, it is recommended that you send the 
data to an NSP-1 and preview it after you finish creating 
the playlist.

See “Checking Playout (Previewing on an NSP-1)” on 
page 53 for details on the preview operation on an NSP-1. 

Creating a Playlist

A new playlist is created using the following procedure:

1 In the BZNP-D1 main window, check that the BZNP-
D1 (PC) option button is selected, and select the group 
for which you want to create a new playlist using the 
Group drop-down list box.

If an unsaved playlist and/or daily schedule for a 
different group is displayed, the BZNP-D1 software 
displays a message asking whether you want to save it.
Save it, if necessary.

2 Proceed to the next step if the Playlist window is 
blank.
When a playlist is displayed, select [Playlist] > [New] 
on the menu bar.
Or, select the Playlist tab in the Content Management 
window, right-click any point on the Playlist tab, then 
select [New] on the popup menu.

If the displayed playlist has not been saved, the BZNP-
D1 software displays a message asking whether you 
want to discard it.
Save the displayed playlist, if necessary.

3 Select [Settings] > [Template Settings] on the menu 
bar.

The Screen Layout window and the Template Settings 
dialog box appear.

4 Select the desired template in the Template drop-down 
list box, then click [OK].

5 Select a piece of material in the Content Management 
window, then add it to the playlist by a drag & drop 
operation.
The layer in which you drop the material is decided 
depending on the material and its purpose.

Template Settings dialog box
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* The area painted with the NSP-1 transparent color will be 
transparent. Refer to the supplied SpecsE.htm file for details.

When a material tab is selected in the Content 
Management window, the background of the layer 
name changes to yellow showing that the data on the 
tab can be dropped on that layer.

The position and size data based on the selected 
template are added to the dropped material and it 
appears on the playlist as an event. The color of the cell 
where the event is specified changes to light blue.

6 Repeat step 5, or from steps 3 to 5 to create the playlist.

If necessary, edit the newly added event, for example, 
modify the duration of the event.

See “Playlist Editing Functions” on page 39 for 
detailed information on playlist editing functions.

When you change a template whose layer settings are 
different, in the middle of the playlist, the layers that 
are not used in the new template will disappear.
The events specified on these layers are still stored, 
and will re-appear if you select a template in which 
those layers are used.
However, when the playlist is saved, the BZNP-D1 
software only saves the events on the layers that are 
used in the template at the time of saving. 
It is recommended that you make the layer settings of 
the templates identical when they may be used in a 
single playlist. If this is not possible, select a template 

in which all the necessary layers are to be used every 
time, before saving the playlist.

7 Select [Playlist] > [Save] on the menu bar of the main 
window.

The playlist is saved. It appears on the Playlist tab of 
the Content Management window.

8 Specify the type and title of the saved playlist.
Select the playlist in the Content Management 
window, then click its Type or Title column. This 
makes the column editable.
Specify the type (up to 20 characters) or title (up to 40 
characters), and then press the Enter key. 

9 To finish working with this playlist, select [Playlist] > 
[New] on the menu bar of the main window to clear the 
Playlist window.

To preview the playlist being edited
Right-click any point in the Playlist window, then select 
[Send the Playlist to NSP-1 and Preview] on the popup 
menu. This sends the playlist that is currently being edited 
to all the NSP-1 players of the selected group and starts 
previewing. Check the contents on the connected display.

To stop the preview, right-click any point in the Playlist 
window again, then select [Stop Previewing].

This operation sends the playlist to all NSP-1 players of the 
group for preview. When there is an ongoing playout on 
the NSP-1 players, the ongoing playout is terminated.

Material Purpose Layer

Video Video (with accompanying 
audio), MPEG4 streaming 
video, video signal input via 
the NSP-1 VIDEO IN 
connector (with 
accompanying audio input 
via the AUDIO IN connector)

Video

Graphics Background, Wallpaper Background

Graphics to be displayed 
under video

Graphics

Logo marks, Down-stream 
keying, Graphics to be 
displayed in front of video

Logo*

Text Captions Text*

URL Web pages Graphics

Flash Flash movies Graphics

Audio Extra audio Audio

Hint

Note

Note
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Editing an Existing Playlist

Opening a playlist

1 In the BZNP-D1 main window, check that the BZNP-
D1 (PC) option button is selected, and select the group 
whose playlist you want to edit using the Group drop-
down list box.

When an unsaved playlist and/or daily schedule for a 
different group is displayed, the BZNP-D1 software 
displays a message asking whether you want to save it.
Save it, if necessary.

2 Select the Playlist tab in the Content Management 
window, right-click the desired Playlist, then select 
[Edit] on the popup menu.
Or, double-click the desired playlist.

When an unsaved playlist for the same group is 
displayed in the Playlist window, the BZNP-D1 
software displays a message asking whether you want 
to discard it.
Save the displayed playlist, if necessary.

The selected playlist opens in the Playlist window.

3 Edit the playlist.

See “Playlist Editing Functions” on page 39 for 
detailed information on playlist editing functions.

4 Select [Playlist] > [Save] on the menu bar of the main 
window.
To save the playlist as a new one, select [Playlist] > 
[Save with New Index] instead.

The playlist is saved. 
When you select [Save with New Index], a new index 
is assigned to the playlist currently being edited.

5 To finish working with this playlist, select [Playlist] > 
[New] on the menu bar of the main window to clear the 
Playlist window.

Modifying the type or title of a playlist

1 Select the Playlist tab in the Content Management 
window.

2 Check that the BZNP-D1 (PC) option button is 
selected, and select the group whose playlist you want 
to edit using the Group drop-down list box.

The playlists of the selected group are displayed in the 
Content Management window.

3 Select the playlist whose type or title you are 
modifying, then click its Type or Title column.

This makes the column editable.

4 Specify the type (up to 20 characters) or title (up to 40 
characters), and then press the Enter key. 

Deleting playlists
The following procedure deletes the playlists stored on the 
PC.

See “Deleting Materials and Schedules Stored on an NSP-
1” on page 59 for the operations used to delete playlists 
stored on NSP-1 players.

1 Select the Playlist tab in the Content Management 
window.

2 Check that the BZNP-D1 (PC) option button is 
selected, and select the group whose playlist you want 
to delete using the Group drop-down list box.

The playlists of the selected group are displayed in the 
Content Management window.

3 Select the playlists to be deleted.
To select more than one playlist, hold down the Ctrl 
key and click the desired playlists in turn.
To select all the playlists in a range, hold down the 
Shift key and click the first and last playlists in the 
range.

4 Right-click the selection, then select [Delete] on the 
popup menu.
Or, press the Delete key on the keyboard.

A confirmation message appears.

5 Click [Yes].

The selected playlists are deleted.
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Copying playlists
The BZNP-D1 software enables you to copy a created and 
stored playlist with the following procedure. A duplication 
can be edited as another playlist, or used for another group 
for which the identical screen resolution and orientation 
have been set. 

1 Select the Playlist tab in the Content Management 
window.

2 Check that the BZNP-D1 (PC) option button is 
selected, and select the group whose playlist you are 
copying using the Group drop-down list box.

The playlists of the selected group are displayed in the 
Content Management window.

3 Select the playlists to be copied.
To select more than one playlist, hold down the Ctrl 
key and click the desired playlists in turn.
To select all the playlists in a range, hold down the 
Shift key and click the first and last playlists in the 
range.

4 Right-click the selection, then select [Copy] on the 
popup menu.

The selected playlists are copied to the Windows 
Clipboard.

5 To use the copied playlists for another group, select the 
desired group using the Group drop-down list box.
Skip this step to use them as new playlists in the same 
group.

6 Right-click any point on the Playlist tab of the Content 
Management window, then click [Paste] on the popup 
menu.

The playlists stored on the Windows Clipboard are 
added onto the list. Their type and title data is the same 
as that of the original playlists, but they are assigned 
new index numbers. The date and time of pasting 
appear in the updated date and time column.

Playlist Editing Functions

The BZNP-D1 software provides the following playlist 
editing functions:
• Adding events (see page 39)
• Deleting events (see page 40)
• Modifying the start time of an event (see page 41)
• Modifying the duration or the end time of an event (see 

page 41)
• Undoing the last editing operation (see page 42)
• Checking or selecting a template (see page 42)
• Adjusting screen layout settings (see page 43)

Adding events

1 To continue using the template currently selected for 
the layout information of the new event, proceed to the 
next step.
To select a different template, or to check the current 
template, perform the operation explained in 
“Checking or selecting a template” on page 42.

2 Select a piece of material in the Content Management 
window.

3 Add the selected piece of material to the playlist by a 
drag & drop operation.
The layer on which you drop the material is decided 
depending on the material and its purpose.

* The area painted with the NSP-1 transparent color will be 
transparent. Refer to the supplied SpecsE.htm file for details.

The dropped material is added to the playlist as an 
event. The color of the cell where the event is specified 
changes to light blue. 

Material Purpose Layer

Video Video (with accompanying 
audio), MPEG4 streaming 
video, video signal input via 
the NSP-1 VIDEO IN 
connector (with 
accompanying audio input 
via the AUDIO IN connector)

Video

Graphics Background, Wallpaper Background

Graphics to be displayed 
under video

Graphics

Logo marks, Down-stream 
keying, Graphics to be 
displayed in front of video

Logo*

Text Captions Text*

URL Web pages Graphics

Flash Flash movies Graphics

Audio Extra audio Audio
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The duration of the added event varies depending on 
the material dropped.
In the case of video, Flash, audio material or scrolled 
text, that has its own duration, the event duration will 
be identical to the material duration.
In the case of one of the other types of materials, the 
duration will be the value defined in the software.

4 Modify the event duration, if necessary.
Right-click the event, and select [Change Duration] on 
the popup menu.

The Change Duration dialog box appears. The current 
event duration is shown in it.

5 Modify the duration as desired, then click [OK].

As the duration of the shortest event on the playlists is five 
seconds, the BZNP-D1 software sets the duration of the 
event for a piece of material whose duration is less than 
that, and it does not allow you to reduce the duration.
If you drop a one-second audio file, for example, the 
duration of the event made from it will be five seconds. 
And on the NSP-1, the audio file will be played during the 
first one second, then there will be no audio in the 
remaining four seconds.
Note this when you handle materials shorter than five 
seconds, as other types of materials will be played in the 
same manner. 

When a material tab is selected in the Content 
Management window, the background of the layer name 
changes to yellow showing that the data on the tab can be 
dropped on that layer.
And, note that material is added to or inserted in the 
playlist, depending on the position where the material is 
dropped, as shown in the following table. 

Inserting an event at the beginning or middle of a playlist 
does not affect the event start times on the other layers. 
Check the start times of the inserted event and the events 
on the other layers, and adjust them, if required.

See “Modifying the start time of an event” on page 41 for 
details.

To use a video/audio input to the NSP-1 VIDEO IN/
AUDIO IN connectors as a video event
The video layer accommodates the video/audio input to the 
NSP-1 VIDEO IN and AUDIO IN connectors upon 
playout, as well as the video material registered in the 
BZNP-D1 software.
This feature enables you to include live video or TV 
programs in the playlists.
When a Flash movie and/or audio events are specified on 
the same line as this external video/audio event, the audio 
input to the AUDIO IN connector will not be output.

1 Right-click the desired cell of the Video column in the 
Playlist window, then select [External Input] on the 
popup menu.

The external video/audio event is displayed as 
“External Input” on the playlist. 

2 Modify the event duration, if necessary, like the other 
kinds of events.
Right-click the added event, select [Change Duration] 
on the popup menu, modify the event duration in the 
Change Duration dialog box, then click [OK].

Deleting events
Right-click the event to be deleted on the playlist, then 
click [Delete] on the popup menu.
Or, select the event to be deleted, then press the Delete key.

When a confirmation message appears, click [Yes].

To select all events on the same line of the playlist, click 
the leftmost Start Time column.

Note

Hint

Position you want to add/
insert the event

Drop position

Beginning of the playlist (While holding down the Ctrl 
key,) drop it on the first line of 
the playlist. 

Last of the playlist Drop it below the last line of 
the playlist.

Blank cell Drop it in that blank cell.

Cell where an event has 
already been specified 
(Overwriting)

Drop it in the cell to be 
overwritten.

Between two consecutive 
cells, each of which has an 
event specified

(While holding down the Ctrl 
key,) drop-it on the lower cell.

Hint

Position you want to add/
insert the event

Drop position
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Modifying the start time of an event

This operation adjusts the start time of an event and cannot 
be used to move the event on the playlist.

1 Right-click the desired event on the playlist, then click 
[Change Start Time] on the popup menu.

The Change Start Time dialog box appears. The 
current start time of the event is shown in it.

2 Modify the start time as desired, then click [OK].

Modifying the start time on the playlist
When you select the event cell whose start time you want 
to modify on the playlist, a handle appears on the top line 
of the cell. The mouse pointer will appear as a two-way 
arrow on the handle.
Selecting that handle and dragging the mouse expands the 
cell and hence modifies the start time of the event.

Modifying the duration or the end time of 
an event
The following procedure allows you to adjust the duration 
of an event.

You can specify the event duration even for video or Flash 
events whose materials have “duration” data.
As the BZNP-D1 software manipulates the materials in 
units of seconds, the very last frames of a video or Flash 
event will not be played if there is a fraction in the actual 
playout length of the video or Flash movie file. By 
expanding the event duration in such a case, the video or 
Flash movie file will be fully played. Note that, however, 
a frozen picture may be displayed as described in the 
following notes.

1 Right-click the desired event on the playlist, then click 
[Change Duration] or [Change End Time] on the 
popup menu.

The Change Duration or Change End Time dialog box 
appears. The current duration or end time of the event 
is shown in it.

2 Modify the time as desired, then click [OK].

In either case, the start time of the line immediately 
below the selected event is changed.

Modifying the end time on the playlist
When you select the event cell whose end time you want 
to modify on the playlist, a handle appears on the bottom 
line of the cell. The mouse pointer will appear as a two-
way arrow on the handle.
Selecting that handle and dragging the mouse expands the 
cell and hence modifies the end time of the event.
This method is useful when you want to specify an end 
time that is identical to an event on another layer.

• When modifying the end time, the specified end time is 
not included in the event duration.
If you specify “15:00:00” as the end time, for example, 
playout of that event will end immediately before 
15:00:00.
The event specified on the next line on the playlist, if 
any, will be started at 15:00:00.

• Expanding the duration of a video, Flash movie or audio 
event whose material has “duration” data will affect 
playout of that event as described in the following table.
When you shorten the duration of such an event, playout 
will be stopped at the end time and the next event will 
start.

Note

Hint

Notes
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• As the duration of the shortest event on the playlists is 
five seconds, the BZNP-D1 software sets the duration of 
the event for a piece of material whose duration is less 
than that, and it does not allow you to reduce the 
duration.
If you specify a one-second audio file, for example, the 
duration of the event made from it will be five seconds. 
And on the NSP-1, the audio file will be played during 
the first one second, then there will be no audio in the 
remaining four seconds.
Note this when you handle materials shorter than five 
seconds, as other types of materials will be played in the 
same manner.

Undoing the last editing operation
Holding down the Ctrl key and pressing the Z key undoes 
the last editing operation.
Note that, however, operations related to the screen layout 
cannot be undone.

Checking or selecting a template
Screen layout, that is a set of the sizes and positions of the 
materials on the display layers (except for the fixed 
positioned background layer), is defined when materials 
are dropped on the playlist.
You can check which template is currently selected, or 
select another template for the materials that you are 
adding to the playlist, in the following procedure:

1 Select [Settings] > [Template Settings] on the menu 
bar.

The Screen Layout window and the Template Settings 
dialog box appear.
The Template drop-down list box shows the template 
currently selected. The Screen Layout window shows 
the layout settings of the selected template.

2 To select another template, select the desired one using 
the Template drop-down list box, then click [OK].
To continue using the current template, simply click 
[OK] or [Cancel] to close the windows.

• When you change a template whose layer settings are 
different in the middle of the playlist, the layers that are 
not used in the new template will disappear.
The events specified on these layers are still stored, and 
will re-appear if you select a template in which those 
layers are used.
However, upon saving the playlist, the BZNP-D1 
software only saves the events on the layers that are used 
in the template at the time of saving. 
It is recommended that you make the layer settings of the 
templates identical when they may be used in a single 
playlist. If this is not possible, select a template in which 
all the necessary layers are set to be used every time 
before saving the playlist.

• There are various limitations in the position and size of 
each layer of an NSP-1. After you finish creating a 
playlist, make sure to check if the materials are displayed 
as intended by previewing the playlist on the NSP-1.

For information on how to preview a playlist, see 
“Checking Playout (Previewing on an NSP-1)” on page 
53.

Material Playout on the NSP-1

Video When playback of the video file finishes, a 
frozen picture of the last frame is displayed 
until the specified end of the event. The 
sound accompanying the video will not be 
output while the frozen picture is displayed. 

Flash movie If the Flash movie was specified to repeat 
when being created, playout will repeat 
from the beginning. If not, a frozen picture 
of the last frame will be displayed just as it 
is with a video event.

Audio After playback of the audio file finishes, no 
sound is output from this layer. So it is 
better not to expand the duration of audio 
events. To repeat an audio file, specify the 
event several times in the playlist according 
to the duration of the file and the time you 
need the audio.

Notes
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Adjusting screen layout settings
Screen layout, that is a set of the sizes and positions of the 
materials on the display layers (except for the fixed 
positioned background layer), is defined when materials 
are dropped on the playlist according to the selected 
template, but you can adjust layout settings of each event 
line later.

In the case of a bitmap on the text layer, the size does not 
change due to the layout settings. Only the layout settings 
specify the position.

1 In the Playlist window, right-click the desired event 
line (any column except for Audio), then select 
[Layout Settings] on the popup menu.

The Screen Layout window and the Layout Settings 
dialog box appears.

Clicking any point in the Screen Layout window 
displays a popup menu. [View: 50%] and [View: 
100%] on the menu change the Screen Layout window 
size.

2 Specify sizes and positions of layers to be used.
Do the following for all the layers, respectively.

• Click the layer in the Screen Layout window, then 
select a handle of the layer and drag it to the desired 
position and size.
When you click any point in the Template Settings 
dialog box, the values change according to the 
position and size of the layer in the Screen Layout 
window. 

• Select the layer in the Screen Layout window, right-
click it, then select [Full-Screen Size], [Quarter-
Screen Size] or [Original Size].
Those size designations can be used for the 
Graphics, Video, and Logo layers. Note that, for the 
Video layer, clicking [Original Size] restricts the 
layer size to 640 x 480 (or 480 x 640) pixels, 
regardless of the original size. And, if a web page is 
specified on the Graphics layer, [Original Size] does 
not work, as the BZNP-D1 software cannot 
recognize the size of the web page.
When you click any point in the Template Settings 
dialog box, the values change accordingly.

• Change the values of the relevant text boxes in the 
Layout Settings dialog box.
After you have changed the values and clicked any 
point in the Screen Layout window, the position and/
or size of the layer(s) change accordingly.

• Place check marks in the Original Aspect Ratio 
check boxes in the Layout Settings dialog box.
When you click the layer in the Screen Layout 
window after placing a check mark for that layer, the 
aspect ratio of that layer returns to that of the 
original. Then, you can change the position or the 
size of the layer, while keeping that aspect ratio.
Original Aspect Ratio check boxes are provided for 
the Graphics, Video, and Logo layers. However, if a 
web page is specified on the Graphics layer, this 
setting does not work, as the BZNP-D1 software 
cannot recognize the size and shape of the original 
web page.
For the Video layer, the aspect ratio will be 4:3 (or 
3:4 if the screen orientation setting is “Portrait”) 
regardless of the aspect ratio of the original video.

3 Click [OK] in the Layout Settings dialog box.

The position and size of each layer of the selected 
event line are stored in the playlist, and the Screen 
Layout window and the Layout Settings dialog box 
close.

Note

Hint

Handle

Screen Layout window

Layout Settings dialog box
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• You cannot change the overlaid order of the layers. 
• The Background layer is always displayed in full-screen 

size.
• There are various limitations in the position and size of 

each layer of an NSP-1. After you finish creating a 
playlist, make sure to check if the materials are displayed 
as intended by previewing the playlist on the NSP-1.

For information on how to preview a playlist, see 
“Checking Playout (Previewing on an NSP-1)” on page 
53.

Notes
Playlist Preparations



  C
hapter 4  R

outine O
perations
Schedule Preparations

To play back contents on an NSP-1, “schedules” must be 
prepared together with the materials and playlists.
Schedules include daily schedules and periodic schedules.
A “daily schedule” defines the start and end times, in a 
day, of each playlist. The playlist will be played repeatedly 
in the specified time. 
A “periodic schedule” defines which daily schedule is to 
be used for a specific day. 

Daily Schedules and Periodic 
Schedules

Daily schedules
The following figure shows an example of a daily 
schedule.
In a daily schedule, playlists to be played and the control 
commands for the NSP-1 audio output level or a device 
connected to the NSP-1, such as a plasma display, are 
specified.

This daily schedule instructs the NSP-1 to perform the 
following operations:

Regardless of the length of each playlist, “Morning Prog.” 
will be played from 10:00:00 in the morning to 1:00:00 in 
the afternoon, “Afternoon Prog.” will be played until 
5:00:00 in the evening, and then “Evening Prog.” will be 

played from 5:00:00.
If the length of the “Morning Prog.” is 40 minutes, for 
example, it will repeat four and half times from 10:00:00, 
then playout will be switched to “Afternoon Prog.” at 
1:00:00 in the afternoon.
Even when playout starts after its start time, the control 
commands operate. In the example designated above, it 
will never happen that playout proceeds without turning 
the power of the plasma display to on.

When the daily schedule is created, the period when the 
daily schedule will be used is specified as the periodic 
schedule, and it is sent to the NSP-1.

Periodic schedules
The following figure shows an example of the Edit 
Periodic Schedule dialog box. 
You will specify the index of the desired daily schedule 
and the period in which the daily schedule will be used for 
playout in this dialog box.

In this example, playout will occur everyday from July 1st 
through August 15, 2004 according to the daily schedule 
whose index is 051000001.

By sending the periodic schedule to the NSP-1, everything 
you need for playout, that is, the required daily schedule, 
the playlists, and materials, is sent with it.

Time Operations
9:59:00 Control (turn on) the plasma display.

10:00:00 Start playout of the “Morning Prog.” playlist.

13:00:00 Start playout of the “Afternoon Prog.” playlist.

17:00:00 Start playout of the “Evening Prog.” playlist.

21:00:00 End playout of the “Evening Prog” playlist.

21:00:01 Control (turn off) the plasma display.
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Creating a Daily Schedule

A daily schedule is created, like a playlist, by adding 
playlists and control commands to the Daily Schedule 
window with drag & drop operations.

The red line in the Daily Schedule window indicates the 
daily five-minute NSP-1 sleep time. As the NSP-1 does not 
play anything nor receive any data during the sleep time, 
the BZNP-D1 does not allow you to specify any playlist or 
control commands on this line.

Creating a new daily schedule
A new daily schedule is created in the following 
procedure:

1 In the BZNP-D1 main window, check that the BZNP-
D1 (PC) option button is selected, and select the group 
for which you want to create a new daily schedule 
using the Group drop-down list box.

If an unsaved playlist and/or daily schedule for a 
different group is displayed, the BZNP-D1 software 
displays a message asking whether you want to save it.
Save it, if necessary.

2 Proceed to the next step if the Daily Schedule window 
is blank.
When a daily schedule is displayed, select [Daily 
Schedule] > [New] on the menu bar.
Or, select the Daily Schedule tab in the Content 
Management window, right-click any point on the 
Daily Schedule tab, then select [New] on the popup 
menu.

If the displayed daily schedule has not been saved, the 
BZNP-D1 software displays a message asking 
whether you want to discard it.
Save the displayed daily schedule, if necessary.

3 Select the desired playlist in the Content Management 
window, then add it to the daily schedule by a drag & 
drop operation.
You can also add control commands to the Control 
column in the same way.

The color of the cell where the event is specified 
changes to light blue.

In the Daily Schedule window, added playlist events 
are shown by their title and control commands are 
shown by marks corresponding to the targets. When 
you move the mouse pointer over a title or a mark, a 

popup window showing the index, type, and title 
appears.

If necessary, edit the newly added event, for example, 
by modifying the duration or start time of the event.

See “Daily schedule editing functions” on page 48 for 
detailed information on daily schedule editing 
functions.

4 Select [Daily Schedule] > [Save] on the menu bar of 
the main window.

The daily schedule is saved. It appears on the Daily 
Schedule tab of the Content Management window.

5 Specify the type and title of the saved daily schedule.
Select the daily schedule in the Content Management 
window, then click its Type or Title column. This 
makes the column editable.
Specify the type (up to 20 characters) or title (up to 40 
characters), and then press the Enter key. 

6 To finish working with this daily schedule, select 
[Daily Schedule] > [New] on the menu bar of the main 
window to clear the Daily Schedule window.

Note
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Editing an existing daily schedule

Opening a daily schedule

1 In the BZNP-D1 main window, check that the BZNP-
D1 (PC) option button is selected, and select the group 
whose daily schedule you want to edit using the Group 
drop-down list box.

When an unsaved playlist and/or daily schedule for a 
different group is displayed, the BZNP-D1 software 
displays a message asking whether you want to save it.
Save it, if necessary.

2 Select the Daily Schedule tab in the Content 
Management window, right-click the desired Daily 
Schedule, then select [Edit] on the popup menu.

When an unsaved daily schedule for the same group is 
displayed in the Daily Schedule window, the BZNP-
D1 software displays a message asking whether you 
want to discard it.
Save the displayed daily schedule, if necessary.

The selected daily schedule opens in the Daily 
Schedule window.

3 Edit the daily schedule.

See “Daily schedule editing functions” on page 48 for 
detailed information on daily schedule editing 
functions.

4 Select [Daily Schedule] > [Save] on the menu bar of 
the main window.
To save the daily schedule as a new one, select [Daily 
Schedule] > [Save with New Index] instead.

The daily schedule is saved. 
When you select [Save with New Index], a new index 
is assigned to the daily schedule currently being 
edited.

5 To finish working with this daily schedule, select 
[Daily Schedule] > [New] on the menu bar of the main 
window to clear the Daily Schedule window.

Modifying the type or title of a daily schedule

1 Select the Daily Schedule tab in the Content 
Management window.

2 Check that the BZNP-D1 (PC) option button is 
selected, and select the group whose daily schedule 
you want to edit using the Group drop-down list box.

The daily schedules of the selected group are 
displayed in the Content Management window.

3 Select the daily schedule whose type or title you want 
to modify, then click its Type or Title column.

This makes the column editable.

4 Specify the type (up to 20 characters) or title (up to 40 
characters), and then press the Enter key. 

Deleting daily schedules
The following procedure deletes the daily schedules stored 
on the PC.

See “Deleting Materials and Schedules Stored on an NSP-
1” on page 59 for details on the operations required to 
delete daily schedules stored on NSP-1 players.

1 Select the Daily Schedule tab in the Content 
Management window.

2 Check that the BZNP-D1 (PC) option button is 
selected, and select the group whose daily schedule 
you want to delete using the Group drop-down list 
box.

The daily schedules of the selected group are 
displayed in the Content Management window.

3 Select the daily schedules to be deleted.
To select more than one daily schedule, hold down the 
Ctrl key and click the desired daily schedules in turn.
To select all the daily schedules in a range, hold down 
the Shift key and click the first and last daily schedules 
in the range.

4 Right-click the selection, then select [Delete] on the 
popup menu.
Or, press the Delete key on the keyboard.

A confirmation message appears.

5 Click [Yes].

The selected daily schedules are deleted.
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Daily schedule editing functions
The BZNP-D1 software provides the following daily 
schedule editing functions:
• Adding events (see page 48)
• Replacing events with another playlist or control 

command (see page 48)
• Deleting events (see page 48)
• Modifying the start time of an event (see page 48)
• Modifying the duration or the end time of an event (see 

page 49)
• Undoing the last editing operation (see page 49)

Adding events

1 Select a playlist or a control command in the Content 
Management window.

2 Add the selected playlist or control command to the 
corresponding column of the daily schedule by a drag 
& drop operation.

The dropped playlist or control command is added to 
the daily schedule as an event. The color of the cell 
where the event is specified changes to light blue. At 
this moment, the duration of the playlist event is 
identical to the dropped playlist, and that of the control 
command event is one second, on the list, regardless of 
the time that would take to complete the task.

3 Modify the duration of the playlist event, if necessary. 
(The duration of a control command event cannot be 
changed.)
Right-click the event, and select [Change Duration] on 
the popup menu.

The Change Duration dialog box appears. The current 
event duration is shown in it.

4 Modify the duration of the playlist event as desired, 
then click [OK].

When you extend the event duration, the playlist will 
be played repeatedly within the duration. When you 
shorten the duration, playout of the playlist will stop in 
the middle.

To insert an event at the top of the daily schedule or 
between two consecutive cells, hold down the Ctrl key and 
drop the desired playlist or control command on the lower 
cell that comes immediately after the insertion point. Then 
adjust the start time and/or duration of the event, if 
necessary. 

Replacing the playlist or control command 
specified in a cell with another 
Paste the desired playlist or control command from the 
Contents Management window by a drag & drop 
operation.

The playlist or control command specified in that cell will 
be overwritten by the newly pasted playlist or control 
command.

Deleting events

1 Right-click the event to be deleted in the Daily 
Schedule window, then click [Delete] on the popup 
menu.
Or, select the event to be deleted, then press the Delete 
key.

A confirmation message appears.

2 Click [Yes].

The event is deleted.

To select both the control command and playlist events on 
the same line of the daily schedule, click the leftmost Start 
Time column.

Modifying the start time of an event

This operation adjusts the start time of an event and cannot 
be used to move the event in the Daily Schedule window.

1 Right-click the desired event in the Daily Schedule 
window, then click [Change Start Time] on the popup 
menu.

The Change Start Time dialog box appears. The 
current start time of the event is shown in it.

2 Modify the start time as desired, then click [OK].
Hint

Hint

Note
Schedule Preparations



  C
hapter 4  R

outine O
perations
Modifying the duration or the end time of a 
playlist event

1 Right-click the desired event in the Daily Schedule 
window, then click [Change Duration] or [Change End 
Time] on the popup menu.

The Change Duration or Change End Time dialog box 
appears. The current duration or end time of the event 
is shown in it.

2 Modify the time as desired, then click [OK].

In either case, the start time of the line immediately 
below the selected playlist event is changed.

When modifying the end time, the specified end time is not 
included in the duration of the playlist event.
If you specify “15:00:00” as the end time, for example, 
playout of that playlist will end immediately before 
15:00:00.

Undoing the last editing operation
Holding down the Ctrl key and pressing the Z key undoes 
the last editing operation.

Exporting daily schedules as CSV files
A daily schedule can be stored as a CSV file using the 
following procedure. A CSV file is a text file in which each 
item in a table is separated by comma. You can use 
spreadsheet applications, such as Microsoft Excel, to open 
CSV files for printing and data processing.

1 Open the daily schedule to be exported.

See “Opening a daily schedule” on page 47 for 
details.

2 Select [Daily Schedule] > [Export CSV File] from the 
menu bar.

The Save as dialog box appears.

3 Specify the folder and file name for the exported CSV 
file, then click [Save].

The displayed daily schedule data is stored as a file 
with a “.csv” extension in the specified folder.
When you open this file using a spreadsheet 
application, playlists and control commands listed on 
the daily schedule are displayed together with the start 
times. On the top line, however, information (index, 
type and title) on the selected daily schedule itself 
appears.   

Note
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Creating a Periodic Schedule

Specifying a playout period
After creating a daily schedule, specify the period when 
the daily schedule will be used to create a periodic 
schedule.

1 In the BZNP-D1 main window, check that the BZNP-
D1 (PC) option button is selected, and then select the 
group for which you want to create a new periodic 
schedule using the Group drop-down list box.

2 Select the Daily Schedule tab of the Content 
Management window, right-click the desired daily 
schedule, then select [Periodic Schedule Settings] on 
the popup menu.

The Edit Periodic Schedule dialog box appears.
The index of the selected daily schedule is shown in 
the Daily Schedule Index text box.

3 Specify the first and last days of the playout period of 
the daily schedule.
Clicking the button of the drop-down list box displays 
a calendar. The date you click on the calendar will be 
specified in the drop-down list box.

4 Place check marks for the days in the Day of the Week 
check boxes to specify specific days of the week in the 
period.
You can click each check box separately, or use the 
[Check All] or [Clear All] button.
To use the specified daily schedule only on Saturdays 
in a period, for example, click [Clear All], then click 
the Saturday check box. 

5 Click [OK].

A new periodic schedule has been created.
It appears on the Periodic Schedule tab of the Content 
Management window.

As the periodic schedules have no index numbers, they 
are listed in the order of the date registered. Note that 
the type, title and index number shown on the Periodic 
Schedule tab are those of the corresponding daily 
schedule, not the periodic schedule’s.
By sending a periodic schedule selected here to the 
NSP-1, the daily schedule, playlists, and materials, 
everything required for playout is sent with it.

See “Sending Data to NSP-1 Players” on page 54 for 
details on sending data to the NSP-1.

When you know the index of the desired daily 
schedule
Instead of step 2 above, you can right-click any point on 
the Periodic Schedule tab, and select [New]. This displays 
the Edit Periodic Schedule dialog box with a blank Daily 
Schedule Index text box.
Select the Playout option button, playout period, and the 
index number of the daily schedule to be used.

Note on overlapped periodic schedules
If more than one periodic schedule is overlapped on a 
certain day, the one that has been sent to the NSP-1 players 
last (most recently) has the highest priority.

For example, the only difference between the following 
two cases is the transfer order. In case A, daily schedule 
051000002 will be used on the 1st and 2nd of August, and 
051000001 will be used on the rest of the days.
On the other hand, in case B, daily schedule 051000001 
will be used throughout the term, and 051000002 will not 
be used.

Columns for type, title and 
index of daily schedules

(Periodic schedules are listed in the order of date registered.)

Non playout period

Periodic Schedule tab
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Periodic schedules case A

Periodic schedules case B

To check the priority on an NSP-1, click the NSP-1 
(Remote Control) option button in the BZNP-D1 main 
window, select the desired NSP-1 in the NSP-1 drop-down 
list box, then click [Update].
After the Updating Information window is displayed, the 
list in the Content Management window shows the 
contents stored on the selected NSP-1. The periodic 
schedule that has been sent most recently, and hence has 
the highest priority, is displayed at the top of the list.

Specifying a non playout period
Periods when no playout will be done on the NSP-1 can be 
scheduled for each NSP-1 group, in the same manner as 
the playout periods.

The non playout periods have higher priority than any 
playout periods, regardless of the transferred order. You 
can specify them in advance.
Note however, that playout will not be done on these non 
playout days even if you send periodic schedules in which 
the same days are specified as the playout period.

1 In the BZNP-D1 main window, check that the BZNP-
D1 (PC) option button is selected, and select the group 
for which you want to create a new periodic schedule 
with a non playout period using the Group drop-down 
list box.

2 Select the Periodic Schedule tab of the Content 
Management window, right-click any point on the tab, 
then select [New] on the popup menu.

The Edit Periodic Schedule dialog box appears.

3 Select the No Playout option button, and specify the 
first and last days of the non playout period.
Clicking the button of the drop-down list box displays 
a calendar. The date you click on the calendar will be 
specified in the drop-down list box.

4 Place check marks for the days in the Day of the Week 
check boxes to specify specific days of the week in the 
period.
You can click each check box separately, or use the 
[Check All] or [Clear All] button.
To specify the Mondays in a period as non playout 
days, for example, click [Clear All], then click the 
Monday check box. 

5 Click [OK].

A new periodic schedule for a non playout period has 

Start date End date Daily schedule 
index

Transferred 
at:

07/01/2004 08/15/2004 051000001 06/30/2004 
10:00:00

08/01/2004 08/02/2004 051000002 06/30/2004 
11:00:00

Start date End date Daily schedule 
index

Transferred 
at:

08/01/2004 08/02/2004 051000002 06/30/2004 
10:00:00

07/01/2004 07/15/2004 051000001 06/30/2004 
11:00:00

Hint

Note
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been created.
It appears as “No Playout” on the Periodic Schedule 
tab of the Content Management window.

6 Send the non playout periodic schedule created to the 
NSP-1 players.

See “Sending Data to NSP-1 Players” on page 54 for 
details on sending data to the NSP-1.

Modifying a periodic schedule

1 Check that the BZNP-D1 (PC) option button is 
selected in the BZNP-D1 main window, and select the 
group whose periodic schedule you want to modify 
using the Group drop-down list box.

The playlists of the selected group are displayed in the 
Content Management window.

2 Select the Periodic Schedule tab in the Content 
Management window, right-click the periodic 
schedule to be modified, then select [Edit] on the 
popup menu. 

The Edit Periodic Schedule dialog box containing the 
current settings appears.

3 Modify the items in the dialog box, then click [OK].

4 Send the modified periodic schedule to the NSP-1.

See “Sending Data to NSP-1 Players” on page 54 for 
details on sending data to an NSP-1.

Deleting periodic schedules
The following procedure deletes the periodic schedules 
stored on the PC.

See “Deleting Materials and Schedules Stored on an NSP-
1” on page 59 for details on the operations required to 
delete periodic schedules stored on NSP-1 players.

1 Check that the BZNP-D1 (PC) option button is 
selected, and select the group whose periodic 
schedules you want to delete using the Group drop-
down list box.

2 Select the Periodic Schedule tab in the Content 
Management window, then select the periodic 
schedules to be deleted.
To select more than one periodic schedule, hold down 
the Ctrl key and click the desired periodic schedules in 
turn.
To select all the periodic schedules in a range, hold 
down the Shift key and click the first and last periodic 
schedules in the range.

3 Right-click the selection, then select [Delete] on the 
popup menu.
Or, press the Delete key on the keyboard.

A confirmation message appears.

4 Click [Yes].

The selected periodic schedules are deleted.
Schedule Preparations
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Checking Playout 
(Previewing on an NSP-1)

The BZNP-D1 software enables you to check how the 
created materials and/or playlists would be played on an 
NSP-1. This is referred to as “previewing.”
You can also preview the materials on the PC. But it may 
not be exactly the same as the playout on the NSP-1. And 
the effects for the playlist cannot be previewed on the PC. 
It is recommended that you preview the playlists using the 
following procedures before you show them to the public.

The methods used for checking text material and control 
commands are not exactly same as those for other 
materials and playlists.
See “Checking a Piece of Text Material” on page 54 and 
“Checking a Control Command” on page 54 for details.

Before Sending Materials and 
Playlists to the NSP-1 Players

This procedure sends the playlist and/or materials to the 
NSP-1, then plays them there.

This procedure sends the playlists and materials to all of 
the NSP-1 players in the selected group and plays them 
there.
If other content is being played on the NSP-1 players, it 
will be terminated.
To preview materials or playlists only on a specific NSP-
1, send the materials and playlists to be previewed, then 
follow the procedure “When Materials and Playlists are 
Already on the NSP-1 Players” described in the next.

1 Check that the BZNP-D1 (PC) option button is 
selected, and select the group to which you are sending 
materials and playlists for preview using the Group 
drop-down list box.

2 In the Content Management window, select the tab 
corresponding to the material or playlist to be 
previewed.
To preview a playlist, for example, select the Playlist 
tab.

3 Right-click the piece of material or playlist to be 
previewed, then click [Send to NSP-1 and Preview] on 
the popup menu.

The BZNP-D1 software sends the selected piece of 
material (or the selected playlist and the required 

materials, when a playlist was selected) to all the NSP-
1 players in the selected group.
On the NSP-1, playout will start automatically when 
preparation for playout is completed. Check the 
playout using the connected display.

4 Right-click any point in the Content Management 
window, then select [Stop Previewing] on the popup 
menu to stop previewing. 
Note that the NSP-1 players remain in the preview 
mode when previewing a piece of material, even after 
playout of the material finishes, until you select [Stop 
Previewing].

When Materials and Playlists are 
Already on the NSP-1 Players

When the materials and/or playlists to be previewed have 
already been sent to the NSP-1 players, you can select a 
specific NSP-1 player for preview.

For detailed operations required in sending materials and 
playlists, see “Sending Data to NSP-1 Players” on page 
54.

1 In the BZNP-D1 main window, select the NSP-1 
(Remote Control) option button, select the NSP-1 
player to be used for previewing in the NSP-1 drop-
down list box, then click [Update].

After the Updating Information window is displayed, 
the contents stored on the selected NSP-1 are 
displayed in the Content Management window.

2 In the Content Management window, select the tab 
corresponding to the material or playlist to be 
previewed.
To preview a playlist, for example, select the Playlist 
tab.

3 Right-click the piece of material or playlist to be 
previewed, then click [Preview on NSP-1] on the 
popup menu.

Playout on the NSP-1 selected in step 1 starts. Check 
the playout using the connected display.

4 Right-click any point in the Content Management 
window, then select [Stop Previewing] on the popup 
menu to stop previewing. 
Note that the NSP-1 player remains in the preview 
mode when previewing a piece of material, even after 
playout of the material finishes, until you select [Stop 
Previewing].

Note
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Checking a Piece of Text Material

To check a piece of text material, select [Send to NSP-1 
and Override Playout] or [Override Playout] instead of 
[Send to NSP-1 and Preview] or [Preview on NSP-1]. And 
use [Stop Overriding] instead of [Stop Previewing].

This operation is also used to override playout on NSP-1 
players with text in an emergency.

See “Overriding Playout with Text in an Emergency” on 
page 57 for details on text overriding operations.

Unlike the cases of other materials, this operation displays 
the selected piece of text material over contents that are 
being played on the NSP-1 players, not stopping ongoing 
playout on the NSP-1 players and displaying text instead.
When there are pieces of text material contained in the 
ongoing playout, they will be replaced with the override 
text.

• When checking a piece of text material using [Send to 
NSP-1 and Override Playout], the NSP-1 players remain 
displaying override text until you select [Stop 
Overriding].
Text overriding continues even after playout of the 
current playlist finishes, or you preview a piece of 
material or playlist.

• When a piece of text material is contained in the ongoing 
playlist, that piece of text will not be displayed 
immediately after you click [Stop Overriding].
Text display starts from the next text event.

Checking a Control Command

To try a single control command on the NSP-1, use 
[Manual Control] instead of [Send to NSP-1 and Preview] 
or [Preview on NSP-1].

Sending Data to NSP-1 
Players

When preparations of the materials, playlists, daily 
schedules, and periodic schedules have been finished, send 
them to the NSP-1 players.
Usually, select the periodic schedules and send them. This 
also sends the daily schedules, playlists, and materials that 
are required for playout of the selected periodic schedules 
simultaneously.
You can also send the daily schedules, playlists, or 
materials, separately.

• Materials, playlists, daily schedules, and periodic 
schedules are all essential to play back contents on the 
NSP-1.

• The BZNP-D1 never sends data that are have already 
been stored on the NSP-1, so that it will not waste time 
and bandwidth.

Sending Data Required for Playout

You can select and send periodic schedules, daily 
schedules, playlists, and materials using the following 
procedure. The periodic schedules for non playout periods 
can be sent in the same way. 

• Playout on the NSP-1 will stop temporarily and restart 
from the beginning of the playlist if you send the 
following data during playout:
- A modified version of the playlist that is being played.
- A modified version of today’s daily schedule.
- A periodic schedule for a period containing today (for 
example, when you send a periodic schedule for a period 
from 8/1 to 8/31 on 8/15).
To avoid affecting playout on the NSP-1, exclude today 
and the past dates in the period. In the case of the 
example above, specify the period from 8/16 to 8/31 and 
send. Avoid sending new versions of playlists and daily 
schedules that are currently being used, too.

• If there is an NSP-1 whose hard disk is full, sending data 
to that NSP-1 will be terminated, but sending to the 
remaining NSP-1 players in the group continues.
After sending data to the group, delete unnecessary data 
on the NSP-1 with insufficient disk space, and resend the 
data. Automatic resending of data to the NSP-1 players 
is not performed if the error was caused by insufficient 
disk space.

Notes

Hints

Notes
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1 Check that the BZNP-D1 (PC) option button is 
selected, and select the destination group using the 
Group drop-down list box.

2 In the Content Management window, select the tab 
corresponding to the material or schedule to be sent.
To send a periodic schedule, for example, select its tab.

3 Select the periodic schedules, daily schedules, 
playlists, or pieces of material to be sent.
To select more than one item, hold down the Ctrl key 
and click the desired items in turn.
To select all the items in a range, hold down the Shift 
key and click the first and last items in the range.

4 Right-click the selection, then click [Send to NSP-1] 
on the popup menu.

The BZNP-D1 software sends the data listed below (if 
it has not yet been sent), depending on the items 
selected, to all the NSP-1 players in the group selected 
in step 1.

The Sending Data window appears to show the 
progress of the data transfer. You can cancel data 
transfer by clicking [Cancel].

See the “Checking Transfer Status” (next) for details 
on the operations required to check the transfer status 
and the status on the NSP-1 player.

Sending data from the Monthly Calendar window
Periodic schedules can be sent from the Monthly Calendar 
window, too.

1 Check that the BZNP-D1 (PC) option button is 
selected in the main window, and select the destination 
group using the Group drop-down list box.

2 Select [View] > [Monthly Calendar] on the menu bar 
to open the Monthly Calendar window if is not 
opened, then display the month corresponding to the 
periodic schedule to be sent.

3 Right-click a date that is included in the period, then 
select [Send to NSP-1] on the popup menu.

The periodic schedule(s) for the right-clicked date are 
sent to the NSP-1 players in the selected group.

When the period of the periodic schedule to be sent 
contains more than one day, you can right-click any of 
the dates within the period.
And, periodic schedules for non playout days can be 
sent to the NSP-1 players in the same way.

If you attempt to send data when data transfer is 
prohibited
On the Network tab of the System Setup window, there is 
a setup item for specifying a time period in which you want 
to prohibit communication with the NSP-1 players.
If you attempt to send data within this time period, the 
BZNP-D1 software waits for data transfer to be enabled, 
and displays a message.
When that time period has passed, the BZNP-D1 software 
automatically starts sending the data you specified, and the 
message disappears.
Note that only limited functions can be used while the 
BZNP-D1 software is waiting for data transfer to be 
enabled. If you cancel the suspended data transmission 
operation, though, you can use any function of the 
software.

Selected item Items to be sent

Periodic 
Schedule

Selected periodic schedules.
Daily schedules specified in the 
periodic schedules.
All playlists used in the daily 
schedules.
All materials required for the playlists.

Daily Schedule Selected daily schedules.
All playlists used in the daily 
schedules.
All materials required for the playlists.

Playlist Selected playlists.
All materials required for the playlists.

Material Selected material.

Number of files that have 
already been sent

Total number of files to be 
sent to all NSP-1 players 
in the group

Note that files already stored on the NSP-1, hence they 
will not be sent, are also included in these numbers. 

Hint
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Checking Transfer Status

Sending many video files and/or sending items to many 
NSP-1 players is especially time-consuming. The NSP-1 
Status window enables you to check how much the most 
recent transfer has progressed and whether or not an error 
has occurred. 
If an error has occurred and the BZNP-D1 software has 
resent data, the number of times it has been resent is also 
displayed in the NSP-1 Status window.

1 Select [View] > [NSP-1 Status] on the menu bar of the 
BZNP-D1 main window.

The NSP-1 Status window opens, and the status of the 
most recent transfer for each NSP-1 player is shown by 
its background color.

The background colors of the lines in the NSP-1 Status 
window represent the following meanings:

The Progress column shows how many of the files to 
be sent have already been sent, and the Retry column 
shows the number of retries, if any.
In the rightmost column of the list, the date and time of 
the last successful transfer to each NSP-1 are shown. 
This helps you, when the NSP-1 players are only 
occasionally connected to the network, to know which 
data has already been sent and which has not. 

Clicking the NSP-1 (Remote Control) option button in the 
BZNP-D1 main window, selecting an NSP-1 using the 
NSP-1 drop-down list box, then clicking [Update] displays 
the contents stored on the selected NSP-1 in the Content 
Management window, after the Updating Status window is 
displayed.
You can check the schedule you have sent here.

Checking NSP-1 status
The BZNP-D1 software enables you to open a web 
browser window from the NSP-1 Status window to check 
the NSP-1 status, as follows:

1 Double-click the line for the NSP-1 whose status you 
want to check in the NSP-1 Status window.

A dialog box appears asking the user name and 
password for accessing the NSP-1.

2 Specify the user name “NSP1status” and the 
appropriate password (The default setting is 
“NSP1status.”) in the respective text boxes, then click 
[OK].

Internet Explorer is started automatically, and the 
status of the selected NSP-1 appears.
(Even when you have associated another web browser 
with the web pages, Internet Explorer is used here.)

Background color Meanings

None (white) No transfer done.

Cyan Now being transferred.

Light blue Successfully transferred.

Red Transfer error occurred. Retried 
but transfer has not been 
completed.

Yellow Not transferred because of 
insufficient disc capacity.
A mark displayed in the Status 
column tells you whether the 
area for video and audio files 
( )or the area for the other 
data ( ) is insufficient.

Hint
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Remote Control of NSP-1 
Players

In addition to sending materials and schedules, the BZNP-
D1 software enables the following remote control 
operations for NSP-1 players via the network.
• Previewing playlist or material on an NSP-1.

See “Checking Playout (Previewing on an NSP-1)” on 
page 53 for details on the preview operations.

• Stopping scheduled playout on an NSP-1.
• Overriding ongoing playout on an NSP-1 with text.
• Controlling the output audio level of an NSP-1 or a 

device connected to the NSP-1.
• Deleting materials and schedules stored on an NSP-1.
• Restoring the NSP-1 original screen saver.
• Replacing schedule data on an NSP-1.

Stopping Scheduled Playout on an 
NSP-1

To stop playout performed in accordance with a playlist 
and daily schedule on an NSP-1, do either of the following.
In either case, ongoing playout will stop, and the screen 
saver playlist will start to play.

Setting today as a non-playout day
Create a periodic schedule in which today is specified as a 
non-playout day, and send it to the NSP-1 players.
Playout on all NSP-1 players in the group will stop.

See “Specifying a non playout period” on page 51 for 
details on how to create a periodic schedule for a non-
playout period, and “Sending Data Required for Playout” 
on page 54 for details on how to send a periodic schedule 
to NSP-1 players.

Deleting a periodic schedule specified for today
Delete the periodic schedule specified for today from the 
NSP-1 player.
This method can be used to stop playout on an individual 
NSP-1 player, but you have to resend the deleted periodic 
schedule later if any day in the future is contained in the 
period.

See “Deleting Materials and Schedules Stored on an NSP-
1” on page 59 for details on how to delete a periodic 
schedule from an NSP-1.

Overriding Playout with Text in an 
Emergency

Normally, you have to prepare materials, playlists, and 
schedule data and send them in advance to NSP-1 players. 
The BZNP-D1 software also provides an “override text” 
function, that is, a function to display a piece of text as 
soon as an NSP-1 receives it. This function is used for 
newsflashes and other emergency information.
In this case, the text information is displayed over the 
contents that are currently being played on the NSP-1. If 
the contents include a piece of text, the override text is 
displayed instead of the original piece of text material.

1 Create a piece of text material to be used for override 
text, if necessary.

See “Creating Text Material” on page 28 for details.

2 Check that the BZNP-D1 (PC) option button is 
selected in the main window, and select the group to 
which you are sending override text using the Group 
drop-down list box.

3 In the Content Management window, select the Text 
tab.

4 Right-click the piece of text material to be used for 
override text, then click [Send to NSP-1 and Override 
Playout] on the popup menu.

The BZNP-D1 software sends the selected piece of 
text to all the NSP-1 players in the selected group.
On each NSP-1, the piece of text material will be 
displayed over the contents that are currently being 
played as soon as the NSP-1 receives it.

You can specify the position at which the override text 
should be displayed in advance.

See “Positioning Override Text” on page 61 for 
details.

5 Right-click any point in the Content Management 
window, then select [Stop Overriding] on the popup 
menu to stop overriding. 
Note that the NSP-1 players will keep displaying the 
override text until you select [Stop Overriding].

Hint
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• The NSP-1 players will keep displaying override text 
until you select [Stop Overriding].
Text overriding continues even after playout of the 
current playlist finishes, or you preview a piece of 
material or playlist.

• When a piece of text material is contained in the ongoing 
playlist, that piece of text will not be displayed 
immediately after you click [Stop Overriding].
Text display starts from the next text event.

When override text is already on the NSP-1 
players
When the piece of text to be used for overriding has 
already been sent to the NSP-1 players, you can select a 
specific NSP-1 player and initiate the text override playout 
on it.

For detailed operations required in sending text material, 
see “Sending Data to NSP-1 Players” on page 54.

1 In the BZNP-D1 main window, select the NSP-1 
(Remote Control) option button, select the NSP-1 
player on which you want to display override text 
using the NSP-1 drop-down list box, then click 
[Update].

After the Updating Information window is displayed, 
the content stored on the selected NSP-1 are displayed 
in the Content Management window.

2 In the Content Management window, select the Text 
tab.

3 Right-click the piece of text material to be displayed, 
then click [Override Playout] on the popup menu.

The selected piece of text material is displayed over 
the contents that are currently being played on the 
selected NSP-1.

In this case, the override text will be displayed 10 
pixels below the top of the screen, regardless of the 
override text position setting. And, text will not be 
centered, even if the “Constant” or “Blink” effect is 
specified

4 Right-click any point in the Content Management 
window, then select [Stop Overriding] on the popup 
menu to stop overriding. 
Note that the NSP-1 player will keep displaying 
override text until you select [Stop Overriding].

• The NSP-1 players will keep displaying override text 
until you select [Stop Overriding].
Text overriding continues even after playout of the 
current playlist finishes, or you preview a piece of 
material or playlist.

• When a piece of text material is contained in the ongoing 
playlist, that piece of text will not be displayed 
immediately after you click [Stop Overriding].
Text display starts from the next text event.

Notes

Note

Notes
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Controlling an NSP-1 or a Connected 
Device

The BZNP-D1 software enables you to control an NSP-1 
player or a device connected to it by using a control 
command registered as content in the BZNP-D1 software. 
The controls include adjusting output audio level of the 
NSP-1 player, turning the power on/off, and switching the 
input signal of the plasma display or projector connected to 
the NSP-1.

See “Registering Additional Control Commands” on page 
33 for details on the operations required to register 
control commands.

You can use control commands stored in the BZNP-D1 
software or those already stored on the NSP-1 players. 
When using a control command stored in the BZNP-D1 
software, it is sent to all NSP-1 players in the selected 
group simultaneously. 

1 Check that the BZNP-D1 (PC) option button is 
selected, and select the target group using the Group 
drop-down list box.
Or, select the NSP-1 (Remote Control) option button, 
select the NSP-1, then click [Update].

2 Select the Control tab of the Content Management 
window.

3 Right-click the control command to be sent, then select 
[Manual Control] on the popup menu.

If you selected the BZNP-D1 (PC) option button in 
step 1, the selected command is sent to all NSP-1 
players in the selected group.
If the NSP-1 (Remote Control) option button was 
selected, the control command is carried out on the 
selected NSP-1.

See “Checking Transfer Status” on page 56 for details on 
the operations required to check the transfer status and the 
status of the NSP-1 player.

Deleting Materials and Schedules 
Stored on an NSP-1

1 In the BZNP-D1 main window, select the NSP-1 
(Remote Control) option button, select the NSP-1 
player whose data you want to delete using the NSP-1 
drop-down list box, then click [Update].

After the Updating Information window is displayed, 
the contents stored on the selected NSP-1 are 
displayed in the Content Management window.

2 In the Content Management window, select the tab 
corresponding to the material or playlist to be deleted.
To delete a playlist, for example, select the Playlist 
tab.

3 Select the items to be deleted.
To select more than one item, hold down the Ctrl key 
and click the desired items in turn.
To select all the items in a range, hold down the Shift 
key and click the first and last items in the range.

4 Right-click the selection, then click [Delete] on the 
popup menu.
Or, press the Delete key.

A confirmation message appears.

5 Click [Yes]. 

The Deleting Data window appears, then the items 
stored on the NSP-1 player are deleted.
You can stop the deletion by clicking [Cancel] in the 
Deleting Data window, but it is not possible to recover 
data that has already been deleted.

The BZNP-D1 software allows you to delete even the 
schedules and materials required for playout.
Make sure not to delete items you need for playout.

Note

Note
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Restoring the NSP-1 Original Screen 
Saver

The following procedure stops using the screen saver 
selected using the BZNP-D1 software (See “Selecting 
NSP-1 Screen Savers” on page 62 for details on the 
selecting procedure.) and restores the NSP-1 original 
screen saver.

This is to delete a periodic schedule stored on an NSP-1 as 
the screen saver data.

1 In the BZNP-D1 main window, select the NSP-1 
(Remote Control) option button, select the NSP-1 
player whose screen saver you want to manipulate 
using the NSP-1 drop-down list box, then click 
[Update].

After the Updating Information window is displayed, 
the contents stored on the selected NSP-1 are 
displayed in the Content Management window.

2 In the Content Management window, select the 
Periodic Schedule tab.

3 Select the screen saver data.
The current screen saver is shown as a periodic 
schedule whose playout period is from “12/31/9999” 
to “12/31/9999.”

4 Right-click the selection, then click [Delete] on the 
popup menu.
Or, press the Delete key.

A confirmation message appears.

5 Click [Yes]. 

The Deleting Data window appears, then the screen 
saver data stored on the NSP-1 player are deleted.
NSP-1 players use their original screen saver stored 
when shipped, if there is no periodic schedule data 
stored as the screen saver.

Replacing Schedule Data on the 
NSP-1

The following methods are used to replace a playlist or a 
daily schedule on an NSP-1 used for playout.
Note that these methods may affect playout currently being 
performed on the NSP-1.

Replacing a playlist
• Select the playlist to be used, then use [Send to NSP-1 

and Preview] (see page 53).
Ongoing playout will be terminated, and playout of the 
selected playlist will start. After playout of the playlist 
ends, click [Stop Previewing], then playout of the 
scheduled playlist or the screen saver will restart from its 
beginning.

• Edit the playlist, then send it (see page 38 and page 54).
In the case of the playlist currently used for playout, 
ongoing playout will pause, then restart from the 
beginning, along with the modified playlist.
In the case of another playlist, the modified one will be 
used from the next time.

Replacing a daily schedule
• Edit the daily schedule, then send it (see page 47 and 

page 54).
In the case of a daily schedule being used today, ongoing 
playout will pause, then restart from the beginning of the 
playlist specified in the new daily schedule.
In the case of another daily schedule, the modified one 
will be used from the next time.

• Create a new daily schedule and a new periodic schedule 
for today, and send the periodic schedule (see page 46, 
page 50, and page 54).
Ongoing playout will be terminated, and will restart 
from the beginning of the playlist specified in the new 
daily schedule. 

Hint
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This section describes the procedures required for making 
the following system setup options:
• Setting the override text position

The BZNP-D1 software provides an “override text” 
function, that is used for newsflashes and other 
emergency information. You can specify the position at 
which the override text should be displayed on the screen 
in advance.

• Setting an NSP-1 screen saver
You can specify a playlist that the NSP-1 plays when no 
playlists are scheduled to play. 

• Managing screen layout templates
For each set of the display resolution and orientation, the 
BZNP-D1 software allows you to create “templates” of 
screen layout, and apply those templates to playlists. 
This section explains mainly how to manage templates.

For detailed procedures on how to create a template, see 
“Making a Screen Layout Template” on page 23.

This section also provides the following initial system 
setup procedures that are not mentioned in Chapter 3.
• BZNP-D1 system setup items
• Details on registering and editing NSP-1 players and 

NSP-1 groups.

Read this section to make the desired settings, if they are 
required.

Positioning Override Text

The BZNP-D1 software provides an “override text” 
function, that is, a function to display a piece of text, such 
as newsflashes and other emergency information, over 
contents that are currently being played on the NSP-1.
The following procedure specifies the position (Y-
coordinate) at which the override text should be displayed.

The BZNP-D1 software has only one setting for the 
override text position. The setting is not specified for each 
piece of text material or for each NSP-1 group.

1 Select the Text tab in the Content Management 
window.

2 Right-click any point on the Text tab, then select 
[Override Text Position Setting] on the popup menu.

The Override Text Position Setting dialog box 
appears.

3 Enter a Y-coordinate (unit: pixels, the top of the screen 
is 0) in the text box for the position where you want the 
top of a piece of override text to be located, then click 
[OK].
When the screen resolution selected is “VGA (640 x 
480)” and the screen orientation is “landscape,” for 
example, specify “0” to display a piece of override text 
at the top of the screen, and a value around “465” (it 
varies depending on the text size) to display it at the 
bottom.

Hint
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• There is no X-coordinate setting. When “constant” or 
“blink” text overrides playout, the override text will be 
aligned at the center of the screen.

• If the specified Y-coordinate points outside of the 
display area, the BZNP-D1 software will adjust the 
specified Y-coordinate automatically so that the override 
text will be displayed at the bottom of the screen.

Selecting NSP-1 Screen 
Savers

You can specify a playlist for each NSP-1 group that the 
NSP-1 players within the group can play when no playlist 
is scheduled for playout. An NSP-1 plays the specified 
playlist when it is powered on and no playlist is scheduled 
for playout.
It is recommended that you choose lively content, such as 
video or moving images, to prevent an image burning into 
the plasma or liquid crystal displays.

This feature is also useful when your operation is simply to 
play a single playlist repeatedly every day.
Simply select the playlist to be played for the screen saver. 
You don’t have to create any daily and periodic schedules 
in such a case.

1 Check that the BZNP-D1(PC) option button is selected 
in the main window. Then select an NSP-1 group from 
the Group drop-down list box where you want to make 
screen saver settings.

2 Select the Playlist tab in the Content Management 
window. 

3 Right-click the playlist you want to select for a screen 
saver, and then select [Change Screen Saver] on the 
popup menu.

The selected playlist is sent to the NSP-1 players, and 
a periodic schedule whose playout period is from “12/
31/9999” to “12/31/9999” is created automatically on 
the NSP-1 players. This periodic schedule is the screen 
saver data you created.

To restore the NSP-1 original screen saver
Delete any periodic schedule whose playout period is from 
“12/31/9999” to “12/31/9999” from an NSP-1. This 
restores the original screen saver that was stored on the 
NSP-1 when it was shipped.

See “Restoring the NSP-1 Original Screen Saver” on page 
60 for details on the operation.

Hints

Hint
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To disable playing the screen saver
When you don’t want to play any screen saver on an NSP-
1, perform the following two:

• When you selected a playlist for a screen saver using the 
BZNP-D1 software, refer to the description “To restore 
the NSP-1 original screen saver” above, and restore the 
NSP-1 original screen saver.

See also “Restoring the NSP-1 Original Screen Saver” 
on page 60 for details.

• On the User Settings web page for the NSP-1 setup, 
select “Off” for “Screen Saver.”

The “Screen Saver” setting on the NSP-1 User Settings 
web page is able to enable/disable the NSP-1 original 
screen saver only.
If you selected and sent a playlist as the screen saver, it will 
be played even if you select “Off” for “Screen Saver” on 
the NSP-1.

Managing Screen Layout 
Templates

The BZNP-D1 software can create a “Template” for screen 
layout according to the NSP-1 resolution and display 
orientation, and then apply the template to a playlist.

For details on how to apply the created template to a 
playlist, see “Creating a Playlist” on page 36.

Displaying the Template Settings 
Dialog Box

You will use the Template Settings dialog box and the 
Screen Layout window to create, edit, or delete a template. 
To display the Template Settings dialog box and Screen 
Layout dialog box, do either of the following:

From the Group Setup dialog box

1 Double-click an NSP-1 group whose resolution and 
display orientation are identical to a “template” to be 
created/edited. 
Or, right-click the desired group, and select [Edit 
Group] from the displayed menu.

The Edit Group dialog box is displayed.

2 Click [Template Settings].

The Screen Layout window related to the screen 
resolution and display orientation specified for the 
selected group, and the Template Settings dialog box 
are displayed.

Note

Group Setup dialog box
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From the main window menu bar

1 Select [Setup] > [Template Settings] from the menu 
bar of the main window.

The Screen Layout window related to the screen 
resolution and display orientation specified for the 
selected group, and the Template Settings dialog box 
are displayed.

You can use the two windows above to create, edit, and 
delete templates.

For information on how to make a new template, see 
“Making a Screen Layout Template” on page 23.

Clicking any point in the Screen Layout window displays 
a popup menu. [View: 50%] and [View: 100%] on the 
menu change the Screen Layout window size.

Editing an Existing Template

With the Screen Layout window and Template Settings 
dialog box, you can change the name and settings of an 
existing template.

Even if you modify a template, the layout settings of the 
existing playlist will not be affected.

Renaming a template

1 From the Template drop-down list box in the Template 
Settings dialog box, select the template that you want 
to rename.

In the Screen Layout window and Template Settings 
dialog box, the size and position of each layer of the 
selected template are displayed.
The name of the selected template becomes editable.

2 Modify the name, and then click [OK].

Editing a template

1 From the Template drop-down list box in the Template 
Settings dialog box, select the template that you want 
to edit.

In the Screen Layout window and Template Settings 
dialog box, the size and position of each layer of the 
selected template are displayed.

2 If necessary, change the settings of the layers that you 
are going to use. 
In the Template Settings dialog box, add a check mark 
to the Use check box of the layers you want to use. 
Clear the check mark in the Use check box for the 
layers that you do not want to use.

When the Use check box is unchecked, the relevant 
layer will disappear from the Screen Layout window.

3 If you want to change the size and position of a layer, 
change the layer settings.
Perform the following to specify the size and position 
of each layer:

• Click the layer in the Screen Layout window, then 
select a handle of the layer and drag it to the desired 
position and size.
When you click any point in the Template Settings 
dialog box, the values change according to the 
position and size of the layer in the Screen Layout 
window. 

Hint

Graphics layer

Logo layer

Background layer

Video layer

Text layer

Screen Layout window

Template Settings dialog box

Hint
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• Select the layer in the Screen Layout window, right-
click it, then select [Full-screen Size], [Quarter-
screen Size] or [Original size].
[Full-screen Size] and [Quarter-screen Size] can be 
used for the Graphics, Video, and Logo layers. 
[Original Size] can be used only for the Video layer, 
and it restricts the layer size to 640 x 480 (or 480 x 
640) pixels.
When you click any point in the Template Settings 
dialog box, the values change accordingly.

• Change the values of the relevant text boxes in the 
Playlist Layout Settings dialog box.
By changing values and clicking any point in the 
Screen Layout window, the position and/or size of 
the layer(s) in the Screen Layout window change 
accordingly.

• For the Graphics, Video, and Logo layers, you can 
set the aspect ratio of the layers identical to that of 
the material file assigned in the playlist, by placing 
check marks in the Original Aspect Ratio check 
boxes.
Note that, however, for layers other than the Video 
layer, the layout changing procedure is required 
during playlist editing to make the aspect ratio of the 
layers identical to those of the material files. 
Otherwise, contents will be shown in the aspect ratio 
of the layers, not of the material files. And, for web 
pages affixed on the Graphics layer, this setting will 
not work, as the BZNP-D1 software cannot obtain 
the size and shape of the original web pages.
For the Video layer, the aspect ratio will be 4:3 (or 
3:4 if the screen orientation set is “Portrait”) 
regardless of the aspect ratio of the original video.

4 Click [OK].

The Screen Layout window and Template Settings 
dialog box close.

• You cannot change the overlaid order of the layers. 
• The background layer is always displayed in full-screen 

size.
• Note that when you use more than one template in a 

playlist, the BZNP-D1 software only saves the events on 
the layers that are used in the template at the time of 
saving. It is recommended that you keep layers which 
you may use in another template, because the layers will 
affect playout only when a piece of material is specified 
as an event.

• Depending on the display orientation (landscape or 
portrait), and the combination and overlapping of the 
layers used, the NSP-1 may not be able to display the 
contents according to the specified layout. After you 
finish creating a playlist, make sure to check if the 
materials are displayed as intended by previewing the 
playlist on an NSP-1.

For details on how to preview a playlist, see “Checking 
Playout (Previewing on an NSP-1)” on page 53.

Notes
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Deleting a Template

When a template is no longer necessary, you can delete it 
using the Template Settings dialog box.

Even if you delete a template, the layout settings of the 
existing playlist will not be affected. 
A template, however, is shared among NSP-1 groups 
whose resolution and display orientation are identical. If 
you delete a template, the other groups using the same 
template cannot use it any longer.

1 From the Template drop-down list box in the Template 
Settings dialog box, select the template that you want 
to delete.

In the Screen Layout window and Template Settings 
dialog box, the size and position of each layer of the 
selected template are displayed.

2 Click [Delete] in the Template Settings dialog box.

A confirmation message appears.

3 Click [Yes].

The selected template is deleted.

4 To close the Template Settings dialog box and Screen 
Layout window, click [OK] or [Cancel].

BZNP-D1 System Setup 
Items

The BZNP-D1 System Setup dialog box appears when you 
select [Setup] > [System Setup].

For details on the procedures required for BZNP-D1 
system setup, see “Setting Up the BZNP-D1 Software” on 
page 20.

In the System Setup dialog box, there are two tabs that 
provide the following setting items:

Content Management tab

BZNP-D1 ID text box
Normally, select “0.”
To use the same materials in a network shared folder from 
more than one computer installed with the BZNP-D1 
software, assign an ID (a single-digit number from “0”-
“9”) to each computer in the BZNP-D1 ID text box. This 
will assign different index numbers to the materials, 
playlists, and schedules depending on the computer that 
created or registered them, hence it reduces the risk of 
overwriting data. 
For example, specify the ID of the BZNP-D1 software on 
the first computer as “1,” and the second as “2.” The 
playlists created on the first one are indexed starting at 
“121000001”, and those created on the second one are 
indexed starting at “221000001.” You will then know 
which one has created a certain playlist. 

Start Index text boxes and Use check boxes for 
Video, Graphics, Text, URL, Flash, Audio, and 
Control
Add a check mark to the Use check box for each type of 
material that you want to use. Clear the check mark for 
each type of material that you do not intend to use. Also, 
specify the starting index number for each type of material 
that the BZNP-D1 software automatically assigns during 
material registration. An index number consists of a 
single-digit number corresponding to the BZNP-D1 ID + a 
two-digit number that indicates material type + a 
sequential six-digit number. The sequential six-digit 
number increases by one as the pieces of material are 
registered.

Start index text boxes for Playlist and Daily 
Schedule 
In the same manner as with the materials, specify the 
starting index number that the BZNP-D1 software 
automatically assigns to playlists and daily schedules upon 
registration.

Note
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999000 and greater index numbers for each piece of 
content are reserved for system use. You cannot enter 
999000 or greater number in the text boxes.

Video Format drop-down list box
Select the video system (NTSC or PAL) of the video 
material that you want to use. Usually you will select the 
video system used in the television system of your country.
Only video material corresponding to the selected video 
system is displayed on the Video tab of the Content 
Management window. 

Base Folder text box
Specify the folder where you want to save the materials, 
playlists, and schedules. They are saved in sub folders 
created in the specified base folder according to their data 
types.
Usually, you need not change the setting. When more than 
one computer installed with the BZNP-D1 software uses 
materials in a network shared folder, enter the absolute 
path, or the relative path from the folder where the BZNP-
D1 software is installed. Or click [Browse] and then select 
the desired folder from the folder tree.
When different operators use different computers to create 
and register materials, edit playlist and schedules, and send 
data respectively, you can make operations much easier by 
specifying the appropriate base folder. Any change in data 
performed by other operators working with a different 
computer, however, will only be checked when the BZNP-
D1 software is started. 

• Video, graphics, Flash, and audio materials created 
using other application programs are not saved under the 
base folder. When they are registered in the BZNP-D1 
software, information describing the original file 
locations is saved together with their material data such 
as data type and titles. 

• If you change the base folder after you create materials, 
playlists, or schedules, you will no longer be able to use 
those materials, playlists, or schedules.

• When more than one computer installed with the BZNP-
D1 software uses materials in a shared folder, if multiple 
operators create or edit the material, playlist, or schedule 
with an the identical index, the newest one will overwrite 
the older ones. To avoid overwriting, specify a different 
BZNP-D1 ID on each computer.

Network tab

Prohibit Network Communication Between spin 
boxes
Specify the time period (24-hour system) when you want 
to prohibit communication with the NSP-1 players. 
Usually the same period as the NSP-1 sleep time is 
specified, but you can set the hours in the daytime so that 
the data will not be sent in the daytime while network 
traffic is heavy. However, note that it is not possible to 
check and delete contents stored on the NSP-1 players, or 
preview content on the NSP-1 player during this time.

If you attempt to send playout schedule data within the 
time period specified here, operation of the BZNP-D1 
software will be suspended. After the time period has 
passed, the BZNP-D1 software automatically sends the 
data to NSP-1 players, as you requested.
For example, where you are allowed to send data only 
during the night, and 10:00 - 22:00 is specified here, the 
BZNP-D1 software waits until 22:00 if you send data at 
17:00. As it automatically sends data after 22:00, you are 
not required to stay at the office.
However, the BZNP-D1 software only accepts limited 
operations while it is suspended. You cannot send data for 
more than one group in the time period specified here.

Note

Notes

Hint
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Detailed Registering and 
Editing Operations for an 
NSP-1 or Group

The section “Registering an NSP-1 and Creating Groups” 
on page 21 explains how to register the NSP-1 players and 
groups that the BZNP-D1 software manages. This section 
explains the detailed setting items and how to modify 
NSP-1 and group registrations. 
You can register or modify NSP-1 players or groups in the 
Group Setup dialog box. To display the dialog box, select 
[Setup] > [Group Setup] from the menu bar.

Changing NSP-1 data

Changing the name, IP address, or 
password
When an NSP-1 player appears in more than one place in 
the Group Setup dialog box, such as the case where it 
belongs to multiple groups, you can select any instance of 
that player to change its settings.

1 In the Group Setup dialog box, double-click the NSP-
1 player whose data you want to change. 
Or, right-click the desired NSP-1 player and select 
[Edit NSP-1] on the popup menu.

The Edit NSP-1 dialog box is displayed.

2 Change the desired items.

For details on each item of the Edit NSP-1 dialog box, 
see “Setting Items upon NSP-1 Registration” on page 
70.

3 If you changed the IP address or password, click 
[Check Connection] to check whether communication 
between the BZNP-D1 software and the NSP-1 can be 
established.

4 Click [OK].

The Edit NSP-1 dialog box is closed.

5 To change the data of another NSP-1 or of a group, 
perform the required operations.
To finish operations in the Group Setup dialog box, 
click [x] at the top right of the Group Setup dialog box 
to close it.

Changing the groups that an NSP-1 player 
belongs to
An NSP-1 player can belong to one or more network 
groups. Perform either of the following procedures to 
assign an NSP-1 player to the desired group or exclude one 
from the group:

To assign an NSP-1 player to the desired group

1 Click the desired group in the Group list box of the 
Group Setup dialog box. 

In the NSP-1 list box, the NSP-1 players belonging to 
the selected group are displayed in gray. Players not 
belonging to the group are displayed in black.

2 Select the NSP-1 player(s) that you want to assign to 
the selected group.

Selected group

Registered NSP-1 
in that group

NSP-1 registered in 
the selected group

NSP-1 not registered 
in the selected group
Detailed Registering and Editing Operations for an NSP-1 or Group
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To select more than one NSP-1 player, hold down the 
Ctrl key and click the desired players one by one.
To select all the NSP-1 players in a specific range, 
hold down the Shift key and click the first and last 
players in the range.

3 Click [Add>>].

The selected NSP-1 players are added to the Group list 
box. They are displayed in gray in the NSP-1 list box.

4 If there is other data that you should change in the 
Group Setup dialog box, perform the required 
operations. If not, click [x] at the top right of the Group 
Setup dialog box to close it.

To remove an NSP-1 player from a group

1 If the NSP-1 players belonging to the group are not 
displayed in the Group list box of the Group Setup 
dialog box, click the node mark (+) next to the group 
name to display the players.

2 Select the NSP-1 player that you want to exclude from 
the selected group.

3 Click [<<Remove].

The selected NSP-1 player is removed from the Group 
list box. It is displayed in black in the NSP-1 list box.

4 If there is other data that you should change in the 
Group Setup dialog box, perform the required 
operations. If not, click [x] at the top right of the Group 
Setup dialog box to close it.

Instead of steps 2 and 3, you can right-click the NSP-1 
player that you want to exclude from the group and select 
[Remove NSP-1] on the popup menu.

Deleting NSP-1 registration
You can delete the registration data of an NSP-1 player 
from the BZNP-D1 software with the following procedure:

1 When the NSP-1 whose registration data you want to 
delete belongs to a group, remove it from the group so 
that it is displayed in black in the NSP-1 list box.

For details on the procedure required to remove an 
NSP-1 player from the group, see “To remove an NSP-
1 player from a group” described above.

When the NSP-1 whose registration data you want to 
delete is displayed in black in the NSP-1 list box, this 
step is not necessary.

2 Select the NSP-1 player that you want to delete in the 
NSP-1 list box.

3 Click [Delete NSP-1].

A confirmation message appears.

4 Click [Yes].

The selected NSP-1 disappears from the NSP-1 list 
box.

5 If there is other data that you should change in the 
Group Setup dialog box, perform the required 
operations. If not, click [x] at the top right of the Group 
Setup dialog box to close it.

Hint
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Setting Items upon NSP-1 
Registration

You can register an NSP-1 player in the Edit NSP-1 dialog 
box. To display the Edit NSP-1 dialog box, click [New 
NSP-1] in the Group Setup dialog box or double-click an 
NSP-1 player that is already registered (or, right-click a 
registered NSP-1 and select [Edit NSP-1] on the popup 
menu).
The Edit NSP-1 dialog box contains the following setting 
items: 

NSP-1 Name text box
Enter a name for an NSP-1 player, which should be unique 
in the system.

IP Address text box
Enter the IP address for the NSP-1 player, which should be 
unique in the system. Make sure to specify the same IP 
address as specified on the NSP-1 player.

Password and Retype Password text boxes
Enter the password that the BZNP-D1 software uses in 
accessing the NSP-1 player in the Password text box. Enter 
the same password in the Retype Password text box to 
avoid specifying a mis-typed password.
Password that is identical to the one set to the NSP-1 
players upon ex-factory is pre-defined in the both text 
boxes. When you change the password on the NSP-1 
player(s), specify the same password in these text boxes.

Check Connection button
Used to check communication to the device with the 
specified IP address in the IP Address text box, and show 
the result.
Note that an incorrect password error will occur if a 
password has been set to the NSP-1 player but you have 
not specified the identical password.

Changing Group data

Changing name, playout time, sleep time, 
screen resolution, and screen orientation

1 In the Group Setup dialog box, double-click the group 
whose data you want to change. 
Or, right-click the desired group and select [Edit 
Group] on the popup menu.

The Edit Group dialog box is displayed.

2 Change the desired items.

For details on each item of the Edit Group dialog box, 
see “Setting Items upon Group Registration” on page 
71.

3 Click [OK].

The Edit Group dialog box is closed.

4 To change the data of an NSP-1 player or another 
group, perform the required operations.
If there is no data that you want to change, click [x] at 
the top right of the Group Setup dialog box to close it.

Deleting the group registration

1 In the Group list box of the Group Setup dialog box, 
select the group that you want to delete, then click 
[Delete Group].
Or, right-click the desired group and then select 
[Delete Group] on the popup menu.

A confirmation message appears.

2 Click [Yes].

The registration of the selected group is deleted and 
the selected group disappears from the Group list box.

3 To change the data of an NSP-1 player or another 
group, perform the required operations.
If there is no data that you want to change, click [x] at 
the top right of the Group Setup dialog box to close it.
Detailed Registering and Editing Operations for an NSP-1 or Group
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Setting Items upon Group 
Registration

You can register an NSP-1 group in the Edit Group dialog 
box. To display the Edit Group dialog box, click [New 
Group] in the Group Setup dialog box or double-click a 
group that has already been registered (or, right-click a 
registered group and select [Edit Group] on the popup 
menu).
The Edit Group dialog box contains the following setting 
items: 

Group Name text box
Enter a name for an NSP-1 group, which should be unique 
in the system.

Playout Time spin boxes
Specify the period (24-hour system) when the NSP-1 
players belonging to the selected group play the contents. 
Within the period specified here, a daily schedule will be 
planned.

Sleep Time spin boxes
Specify the five-minute period (24-hour system) when the 
HDD of the NSP-1 player enters the stand-by (sleep) mode 
once a day. We suggest that you specify a time when no 
data is played or received. At the end of the sleep time, the 
NSP-1 player restarts automatically. 

• The NSP-1 player cannot play materials or receive files 
24 hours a day, every day. Note that the NSP-1 does not 
play any content or receive data during the sleep time.

• Make sure to specify the identical period as that 
specified on the NSP-1 player. The settings done in the 
BZNP-D1 software are not reflected on the NSP-1 
player.

Screen Resolution drop-down list box
Select the resolution according to the display you are 
using. 
When you have selected “Composite” for “Display” on the 
NSP-1 System Settings page, that has been viewed using a 
web browser, select “VGA” here. 

Screen Setting drop-down list box
Select whether you are going to install the display in 
ordinary landscape orientation or in portrait orientation.

You cannot change the screen resolution and orientation 
settings if a playlist or schedule has already been created 
for the group. Delete all the playlists, and daily and 
periodic schedules before changing, or create another 
group.
And, when a playlist and/or daily schedule is displayed in 
the respective windows, you cannot change the screen 

resolution and orientation settings. Clear them by selecting 
[Playlist] > [New] or [Daily Schedule] > [New] before 
changing them.

Layout Settings button
Used to display the Screen Layout window and the 
Template Settings dialog box to create and manage playlist 
layout templates.

For details on the procedure used to make the templates, 
see “Making a Screen Layout Template” on page 23, and 
for information on how to manage the templates, see 
“Managing Screen Layout Templates” on page 63.

Notes

Note
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Actual file
The video, graphics, audio, and Flash 
files created for playout on the NSP-
1 players.
Original files created with 
conventional application software are 
referred to as the “actual files.”
The BZNP-D1 software allows you 
to register the locations and other 
attributes, such as titles, of these files 
as materials. 

Contents
Information, such as video and still 
images, text, sound, and music, and 
any combinations of this information.
In the Content Management window, 
playlists and schedules are added, so 
that all items that are required for 
playout on the NSP-1 players are 
registered as “contents.”

Control, Control command
A system provided to control an 
NSP-1 or a device connected to an 
NSP-1. Actions such as adjusting 
output audio level of the NSP-1 
player, turning the power on/off, and 
switching the input signal of the 
plasma display or projector, etc., are 
available.
Some commands for the NSP-1 and 
Sony’s plasma displays whose 
operations have been confirmed in 
combination with the NSP-1 are 
supplied with the BZNP-D1 
software. You can add more control 
commands.

Daily schedule
Listed information for each day in 
which sets of a time period and 
playlist to be played in that period are 
specified like a time table.
The control commands for adjusting 
output audio level of an NSP-1 player 
or for devices connected to the NSP-
1, such as plasma displays, can be 
specified in the daily schedule, too.

Event
A record of data specified in a cell of 
the playlist or daily schedule.

In the case of a playlist, an event is 
created by dropping a piece of 
material on the playlist. The event 
contains information on the dropped 
piece of material, start time, duration, 
and position and size on the screen.
In the case of a daily schedule, an 
event is created by dropping a playlist 
or control command. The event 
contains information on the dropped 
playlist and start time, or on the 
dropped control command and the 
time when the command will be 
carried out.

Flash file, Flash movie
A file in the Macromedia Flash 
format (.swf). It is used to display 
animation on web browsers.
On NSP-1 players, Flash movies are 
played using the Macromedia Flash 
Player.

Group
NSP-1 players classified according to 
the contents to be played, the 
resolution, and the orientation of the 
display.
The BZNP-D1 software manages 
NSP-1 players by groups. Playlists 
and schedules are created for each 
group, not for each NSP-1 player, and 
data transfer is done group by group. 

Index
A nine-digit code (number) used to 
identify the materials, control 
commands, playlists and daily 
schedules by the BZNP-D1 software. 
When you add a new piece of 
material or create a new schedule, a 
new index is assigned to it.
In the Content Management window, 
all items except for the periodic 
schedules are displayed with their 
respective index numbers.
Note that 999000 and greater index 
numbers for each content are 
reserved for system use. The index 
numbers available for users are 
between 000001 and 998999.

Layer
One of the five display or one audio 
layer, of the NSP-1 player.
The NSP-1 plays a single piece of 
material at a time on each layer, 
according to the playlist.
The display layers are overlaid in the 
order as shown in the following 
figure. (The numbers in the figure 
show the order.)

Graphics material is displayed on any 
of the background, graphics, or logo 
layers. And the graphics layer can 
display Flash movies and web pages 
(URL) in addition to graphics 
material.

Layout
The positions and sizes, on the 
display, of materials that are played 
simultaneously. The positions and 
sizes of the layers (except for the 
audio layer) determine display of one 
piece of material at a time.
Each event of the playlist has layout 
information even though it is not 
displayed on the list.
Normally, layout information is 
automatically added to the event 
according to the selected template, 
but you can adjust the layout on the 
event line of the playlist.

Material
Video, graphics, text, URL (web 
pages), audio, and Flash files 
registered in the BZNP-D1 software. 
Playlists are created by listing these 
materials in the order of playout. (A 

Logo (4) Video (3)Graphics (2)

Text (5)

Background (1)
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piece of material listed on the playlist 
will be an “event.”)
Control commands are sometimes 
included in the “materials” though 
they cannot be listed on the playlists.

Periodic schedule
Definitions of the period when a 
specific daily schedule will be used, 
or the period when no playout will be 
done on the NSP-1.
To play back contents on the NSP-1, 
the periodic schedule and daily 
schedule are as essential as the 
materials and playlists.

Playlist
Listed information that defines the 
order of materials to be played on 
each layer of an NSP-1.
When a piece of material is dropped 
on the playlist, information on the 
start time, duration, position and size 
on the screen is added, and the item 
appears in the cell of the playlist as an 
“event.”
The created playlists will be included 
in the daily schedules, together with 
the information on the time of 
playout.

Preview
To play back materials or playlists 
before distributions or showing them 
to the public, to check the content.
Previewing is normally done by 
sending materials or playlists to the 
NSP-1 player to which the display for 
preview is connected and playing 
these items on it.
Materials except for text can also be 
previewed on a PC using the 
application programs associated with 
them.

Schedule
This word includes “daily schedule” 
and “periodic schedule.” It defines 
the schedule of playout on the NSP-1 
player.

Screen saver
A playlist that will be played on the 
NSP-1 player when nothing is 
scheduled to be played.
The NSP-1 player will play that 
playlist if it is powered on and no 
particular playlist is scheduled for 
playout at that time.

It is recommended that you choose 
lively content, such as a video or 
moving images as a screen saver, to 
prevent image burning into the 
plasma or liquid crystal display.

Template
A set of layout settings that can be 
saved in the BZNP-D1 software. 
This feature is provided to reduce 
time and efforts to specify layout 
settings for every event on the 
playlist. The BZNP-D1 software can 
store up to 20 templates for each 
combination of the screen resolution 
and orientation. To change the 
layout, one of the templates can be 
chosen, then the layout settings of 
that template are automatically 
specified for events thereafter, and 
recorded as such in the playlist. 
You can adjust layout settings for 
each event line later, if you would 
like to change them. 

Title
Text (up to 40 characters) used to 
identify materials, control 
commands, playlists, and daily 
schedules. This title is used together 
with the “type,” and it is not 
necessary that this title be unique.
In the Content Management window, 
you can assign a title to any kind of 
data except for periodic schedules.

Type
Text (up to 20 characters) used with 
the “title” to identify materials, 
control commands, playlists, and 
daily schedules.
In the Content Management window, 
you can assign a type to any kind of 
data except for periodic schedules.
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